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•	Much improved ePanel, now with depth control

•	Drastically improved voxel surface sculpting toolset. Major 
speed improvments to these tools allow for faster sculpting

•	Planar brush, performs as a wood plane

•	Chisel brush

•	Muscles brush

•	Toothpaste brush

•	Barelief tool

•	Sf.Freeze, brush based masking tool for all other surface tools

•	Improved the surface sculpting Flatten brush

•	New voxel Free Form Primitives

•	Render tab improvements. 
Realtime rendering while 
tweaking render params 
& multiple colored light 
sources

•	New polygon Reduction 
tool. This will reduce the 
amount of polygons on 
your mesh based on per-
centages. If no mesh exists, 
it will create a triangulated 
mesh on the fly

•	Much improved voxel bak-
ing tool. When baking from voxels to Pixel Painting objects, 
each voxtree object will have a sub-object Layer created 
automatically

•	Added new and hugely improved UV Editing Tools

•	Added ABF++ Unwrapping method for creating UVs

•	Improved the functionality of the Voxel Curve tool

•	Improved functionality of the Splines mode in the ‘E’ panel

1. What’s new in 3D-Coat 3.2? 
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2. Getting started
2.1  Importing Meshes
With the middle column select, pick one of these .OBJ files that 
you can see in the menu from the screenshot below. Or select file 
menu and click on File->Import->Model for per pixel painting, 
then choose the “sample.obj” file (it is in the Samples folder). 
Upon importing an object you will be prompted with the follow-
ing image. There are many options you will see in this prompt. 
They are as follows:
Initial subdivision. Set initial subdivision of the object for a 

smoother look (if needed).
UV-mapping type. Keep the original UV or use Auto-mapping.

UV-set smoothing. This option works only if you have chosen 
to subdivide the model during import.

Auto-smoothing groups. This option allow you to create 
smoothing groups automatically. By specifying a value in the 
Maximum angle option responsible for the maximum angle 
between faces when the edge becomes sharp, it is necessary 
to activate the Auto-smoothing groups option. To use this 
option, turn the Auto-smoothing groups on.

UV-set name. Enter UV-set name.
Texture width. Set the texture width.
Texture height. Set the texture height.

•	Note: If your video card has less then 256 Mb of RAM you 
should avoid textures larger than 2000×2000.

•	If you choose File->Import->Model for microvertex paint-
ing and you have selected a file (we recommend to start 
with “sample.obj” in the Samples folder). As with the previ-
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ous method, you will see a number of options which you can 
specify upon importing your object. 

Millions of Polygons. This is responsible for mesh resolution, 
the number of millions of polygons after mesh smoothing 
during the loading. This amount should be greater than the 
amount of pixels in your texture image. These polygons are 
used to create normal maps on the fly.

Carcass Resolution (Polygons). The mesh consists of two levels 
of detail: carcass mesh (mid-poly mesh) and high resolution 
mesh. Usually you will see mid-poly mesh in the viewport 
with the normal map created using high-poly mesh.

Smooth Object. You can also “smooth” the object while opening 
the file. For this case, let’s tick Smooth object.

Mapping Type. By default, the UV-mapping type is Keep UV. 
For this option of course, you must have a pre-existing UV 
mapped mesh, and it remains unchanged – but if you want, 
you can change it. For this example, we will leave it as it is.

UV Subpatch Smoothing. This option lets you smooth sub-
patched UVs.

Preserve Positions. With this option you can specify the initial 
vertex positions to be saved, compensating for their shift 
when smoothing by extra pressure.

Ignore Smoothing Groups. This lets you import meshes without 
normals data. In this case, the model will be smoothed after 
the import.

Invert Normals. Check this option if you want to invert the nor-
mals of the model.

Auto-Smoothing Groups. This option lets you create smooth-
ing groups automatically. By specifying a value in the Max. 
angle option responsible for the maximal angle between 
faces when the edge becomes sharp, it is necessary to acti-
vate the Auto-smoothing groups option.

•	UV Set Name, Texture Width & Texture Height are the same 
as above for per pixel painting.

2.2 Customizable Interface
Like many other applications, 3D-Coat lets you customize your 
workspace to suit your needs. You can hide or show windows, 
move tabbed popup windows around and even dock/undock 
them, or turn them into floating windows. If you don’t need or 
want to see a particular window, simply close it. You can always 
restore it to the interface through the Window menu at any time. 
Customizing your workspace makes 3D-Coat work for you in the 
way which best suits your needs and workflow.
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2.3 Tabbed Popup Windows
Let’s take a look at how you can work with the interface. We’ll start 
off by moving tabbed popup windows around. We will discuss 
how to undock and dock tabbed windows and even how to cre-
ate floating windows. Tabbed windows are flexible in that you 
can change their widths and lengths and also their locations. This 
can be helpful if you’re using 3D-Coat on a notebook computer 
and need to have as much screen real estate as possible to model 
or to do texture work. Simply place your mouse along the edge 
or border of a tabbed window, and when your cursor turns into 
a double-headed arrow, drag your mouse to resize the window. 

To show a tab that you may have closed, or to explore tabs 
available for your use, go to the Window menu. From here you 
can choose a tab to reveal in the interface. A great way to learn 
about the tools in 3D-Coat is to open tabbed windows and to 
explore all of the functionality in them.

Moving a tabbed window to a new location is easy. You may 
want to move a tabbed window into another cluster of tabs. A 
good example may be to drag all windows that deal with colors 
or pens into their own cluster so you can quickly find them.

Place your mouse over the tab and drag it to a new loca-
tion. Let go of the mouse when you see a blue outline. The posi-
tion of the outline will determine which part of the window the 

tab will occupy. Let go of the 
mouse and the tabbed window 
will dock where the blue out-
line appeared. Don’t worry if 
you placed it in the wrong loca-

tion. You can always reposition 
tabbed windows until you’re 
satisfied with their locations.

You can create a floating 
window by dragging the tab 
away from the tabbed window 
group it once occupied. Let go of the mouse and it will float as 
its own independent window.

You can dock a floating window back into any cluster of win-
dows by dragging the window and dropping it when you see 
the blue line.

2.4 Popup Window Menus
Many menus in 3D-Coat have a small downward-pointing arrow 
in their upper right hand corners. When you click and hold your 
mouse cursor on them, they pop open to reveal menu-specific 
options. Let’s say that you prefer larger icons when viewing Pens. 
Open the popup menu on the Pen tabbed window and choose 
Large to change the display size of the preview icons.

2.5 Navigation Panel
The navigation panel is located on the top right corner of the 
viewport. You can do many things with it, but first let’s take a look.
Adjust light ambient. By hold-

ing Lmb and moving the 
mouse.
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Adjust light brightness. By 
holding Lmb and moving 
the mouse.

Move light. By holding Lmb 
and moving the mouse.

Rotate camera. By holding 
Lmb and moving the mouse. To rotate camera without this 
control, use Alt+Lmb (or Lmb pressed on an empty space).

Zoom Camera. By holding Lmb and moving the mouse. To scale 
the scene without this control, 
use Alt+Rmb (or Rmb pressed 
on an empty space).

Vary field of view. Rmb to reset it to default.
Set camera to default posi-
tion.
Toggle perspective/ortho-
graphic projection.

2.6 Camera Options
You can switch between two 

custom navigations: 3D-Coat and Maya styles. By default the 
3D-Coat style is set. With 3D-Coat navigation style you can 

rotate your scene by moving 
your mouse with Lmb pressed 
on the empty area. In the same 
way you can zoom your scene 
with Rmb and pan with Mmb. 
If you don’t want to move your 

cursor aside you can always use Alt+Lmb, Rmb, Mmb to navi-
gate the scene.

There is a set of options to customize the background. You 
can also customize the navigation according to you own prefer-
ences. These options are mostly self-explanatory, but the ones 
that are not are detailed below.
Add camera shortcut. Information about the camera position 

and current material placement will be stored. It can be used 
for frame sequence render-
ing.

Delete camera shortcut. 
Delete last used or added 
shortcut.

Switch to previous shortcut. 
Switch to previous camera 
and material shortcut.

Switch to next shortcut. 
Switch to next camera and 
material shortcut.

Pivot Points. There are a num-
ber of options to set a pivot 
point for scene rotation. 
Choose whatever best suits 
you.

Setting up Backgrounds. If 
you’d like to assign an 
image to the background 
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of the interface, you can choose 
one from your hard drive. Open 
the top menu, open Edit-

>Preferences. Scroll down and locate the Background type 
option and click the drop-down arrow to select the Use Back-
ground image. By default, you will see a backdrop that looks 
like a star field. You can of course choose your own file by 
clicking in the file requester field.

2.7 Viewport Reference Images
It’s easy and fun to open up 3D-Coat and, without any references 
at all, just start creating models. But sometimes you’ll need to cre-
ate a model for a client that needs to conform to exact specifica-
tions. Many times a client will provide turnarounds of characters 
or ask you to create them.

This is where placing the viewport reference images comes 
in handy. The reference image 
can be placed on any axis of 
your choosing, x, y, or z. You can 
even assign a different image 
to each axis so you can have a 
view of your artwork no matter 
which axis you happen to work 
from.

Let’s take a look at how to 
assign images to the z axis. Click 
on the arrow next to the Cam-
era controls, then select, Back-

ground->Choose ref image for Z-axis. Once you have clicked the 
menu, you’ll then navigate your hard drive for an image to use 
along the z-axis. The image you select will appear in 3D-Coat’s 
main window. Also, a pop-up 
menu with positioning and 
scaling tools will appear. Use 
the tools along your image or 
the Reference images pop up 
menu to resize, reposition or 
show and hide the image. You 
can even change the opacity of 
the image so it’s easier to focus 
on your modeling tasks.
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3. Right Side Panel
3.1  The Pen Tab
Let’s take a look at the right side dockable panel. The first is 
the Pen tab. Choose a pen you like from the list of pens. This 

is a list of all the default pens 
within 3D. You can add your 
own pens in TGA, .psd or ABR 
format (the pen format used in 
Adobe Photoshop). Press on the 
Folder icon to add a pen. The 
pen added will appear in the list 
of pens available. You can use a 
3D model as a pen. A pen can 
be colored, provided the image 
contains an alpha-channel. In 
this case the alpha-channel will 
be used as a mask for depth. 
You can use Ctrl or Shift to 

select several pens, and you will then see several pens selected in 
the preview, these will be used 
randomly. 

In the pen selection mode 
you can adjust the pen fur-
ther. To change the pen radius, 
use the keys “[“ and “]” or the 
mouse wheel (provided the cor-
responding adjustments were 

made in the Preferences menu). 
To change the pen depth, press 

“ – ” and “+” or the mouse wheel 
(provided the corresponding 
adjustments were made in the 
Preferences menu). You can do the same using the sliders in the 
top pen panel.

Choose a pen, set radius to “20” and try drawing on the object. 
Increase radius, choose another pen shape and draw a bit more. 
Use the “T” key to quick access the pen menu. First press Shift 
and draw again. You will see the surface become smoothed. 
Change the smoothing intensity using the Smoothing slider. 
First press and hold on Lmb, then press Shift and draw again. 
You can now draw perfectly straight lines. Click Ctrl to draw 
cavities – these cuts into the existing model. 

You can rotate your pen. Rotation parameters are from 1 to 
360 degrees. You may use hot keys “(“ and “)” or the mouse 
wheel (under corresponding settings in the Preferences menu) 
to rotate the pen clockwise or counter-clockwise. You can see the 
red line rotating on the pen cursor when “(“ or “)” is pressed. If 
you choose an asymmetrical pen shape, then this rotation shows 
the pen orientation.
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3.2 The Pen Options Tab
Every slider has small mouse icon nearby. Change it to pen icon 
if you want that parameter to depend on pen pressure. Here is 
the list of parameters:
Depth modulator. It is used to specify the standard depth for 

each pen in use.
Rotation amplitude. The amplitude of additional random pen 

rotation.
Radius variation. The degree 
of random pen radius variation 
(in percentages).
Depth variation. The degree of 
random pen depth variation in 
percentages.
Opacity jitter. Jitter of Opacity.
Jitter. Jitter of the pen.
Random flip X. Flips pen ran-
domly along its x-axis.
Random flip Y. Flip pen ran-
domly along its y-axis.
Draw by spots. With this option 
a moving pen will draw with 
separate spots, as opposed to 
stretching lines.

Rotate along motion direction. With this option, the pen slopes 
in the direction of motion. If you rotate the pen manually, 
the angle of rotation will be added to the inclined angle as 
a result of the pen’s motion.

Skip eraser. Don’t use eraser 
Layer of the pen.

Use spacing. With this option, 
drawing with pen move-
ment will be done with 
patches placed at equal 
intervals from each other.

Spacing. Set spacing distance.
By pressing Rmb on any of 
the non-standard pens you 
will see the advanced menu, 
which allows further editing 
and options. These options are:
Pen settings. Go to the pen options tab.
Delete pen.
Save to .psd/.tif. Store the pen to a .psd or 16-bit .tif file. 

.psd is more intuitive, .tif 
is more precise. The .tif 
file can contain 7 chan-
nels – RGB, Alpha, Height, 
Specular and Erase mask). 
Read about this channel 
structure below.

Load from .psd/.tif. Load a 
pen from .psd or 16-bit 

.tif. The .tif filess can con-
tain up to 7 channels. The 
table shows how different 
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numbers of channels will be handled: (CH = Channel, HT = 
Height, A = Alpha, Spec = Specular & Erase Mask)

•	1 CH: treated as A & HT

•	2 CH: 1 – A 2 –HT

•	3 CH: 1, 2, 3 – RGB, 2 – A, H

•	4 CH: 1, 2, 3 – RGB, 4 – A, H

•	5 CH: 1, 2, 3 – RGB, 4 – A, 5 – H

•	6 CH: 1, 2, 3 – RGB, 4 – A, 5 – H, 6 – Spec

•	7 CH: 1, 2, 3 – RGB, 4 – A, 5 – H, 6 – Spec, 7 – Erase mask

NOTE: In the case a .psd file has no structure as described, it will 
simply be unrecognized by the program.

Edit in ext. editor. Edit the pen in an external image editor 
(Adobe Photoshop by default). A .psd file will be saved and 
it will be loaded automatically after any changes. As soon as 
you save the file, 3D-Coat automatically reloads the pen. In 
Adobe Photoshop, the pen image has the structure as seen 
in this image.

Each pen includes four Layers. Color, Height Map (Depth), 
Specular Map (Specular) and an Erase Mask (Erase). Let’s 
take a look at these Layers individually:

Color. This contains the pen color and its transparency mask. 
The transparency mask affects the specular channel as well 
(Specular).

Height Map. This contains the pen height map. Middle grey RGB 
(127,127,127) corresponds to zero height. Darker colors corre-

spond to concave areas, lighter 
colors to convex areas.
Specular. White color corre-
sponds to maximum specular-
ity, black color to the absence 
of specularity. Keep in mind 
that the color map transpar-
ency mask gets applied onto 
the specular map, too.

EraseMask. This mask lets you erase the Layer contents on the 
mask before pen drawing. This may be used to create pens 
which will not collide with each other when drawing. An 
effective application would be interstice, chaps on skin, fabric. 
Keep in mind that the erase mask affects the lowest Layer. 

A few other things that you can do: 
Edit as 16-bit .tif. Edit the pen as a 16-bit .tif file in an external 

editor (Adobe Photoshop by default). A .psd file will be saved 
and it will be reloaded 
automatically after every 
change.

 – >NewFolder. This lets you 
copy the selected pen(s) to 
a different folder.

Pen Tab Drop-down List. On 
the right side of the tab, 
you’ll see an arrow point-
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ing down. By clicking this there will be many more advanced 
options:

Refresh pens preview.
Pen Settings. Goes directly to the Pen opt. tab.
Add new folder. Creates a new folder.
Add existing folder. Add images from a folder with pictures. A 

new pens/strips folder with the same name will be created. 
You should select at least one file in the folder and all files 
from the folder will be added to list. Note: In Folder menu 
you can switch between folders you have created.

Icon Size. You can also change the size of the icons, to a number 
of sizes. They are: Tiny, Normal, Large and Huge.

Create a pen from a 3D Object. By clicking on the Folder icon in 
the Pen Tab, you can import a number of 3D file formats to 
be used as a pen. In the image on the right, you can see the 
editing viewport for importing a 3D mesh. The model can be 
rotated and scaled. Rotate the model by pressing Lmb, move 
the model with Space, scale it with Rmb, rotate within the 
screen frame with Alt+Lmb. You can choose the texture size 
and the image proportions. The use of non-square pens is 
especially handy when creating strips – as described below. 
With the slider in the right lower corner you can adjust the 
model’s level of “dipping” into the background plane – which 
determines the zero pen level.

3.3 Pen Options in the Tool Bar
Some pen options are on the top menu bar. You’ll notice that as 
you change your tool, so will a portion of the menu bar. These 
options are: Soft stroke, Pressure Dependencies, Radius, Smooth-
ing, Depth, etc.
Soft stroke. In this mode, strokes will be more accurate because 

of an additional smoothing of their trajectory.
Radius. This lets you change the size of your pen in the viewport 

with a slider, or by manually keying in a value.
Falloff. This lets you control the brush with with a fall-off curve, 

giving tighter control over the area the brush will affect.
Depth. This lets you to change the intensity of the depth of your 

strokes with a slider, or by manually keying in a value.
Transparency. This lets you change the intensity of the color 

channels transparency up and down with a slider, or by man-
ually keying in a value.

Specularity. This lets you change the intensity of the specularity 
channel up and down with a slider, or by manually 
keying in a value.

Smoothing. This lets you change the intensity of the 
smoothing up and down with a slider or by manually keying 
in a value.

Channel Toggle Icons. 3D-Coat has three channels that you can 
paint at any given moment. They are from left to right: Depth, 
Color and Specularity. These icons will, upon Lmb clicking, 
toggle the channel on or off. If the channel is off, you will 
see a large “X” over the respective icon. If you hover over 
each icon you will notice that there are a few more options 
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for each, which can also be controlled with Rmb + dragging 
up/down or left/right. Rmb and dragging your mouse up/
down will change the intensity of your pen. Rmb and drag-
ging your mouse left/right will change the size of your pen.

Mouse, Pen and Lock Icons. These two icons indicate what mode 
your style is currently in. You can toggle from one to the other 
simply by Lmb clicking on the icon. The Mouse icon locks 
pen pressure to whatever value you have in the respective 
setting the icon is next to. The Pen icon allows for pen pres-
sure directly from your stylus. The Lock icon will lock the “on 
screen” size of the pen. It is convenient when you want to 
change radius of the pen by simply moving the model back-
ward and forward in space. The Lock icon near depth slider 
lets you vary the pen radius without variation of absolute pen 

depth. In standard mode, radius and depth are proportional.
Minimizing on the Tool Bar. You can also change settings on 

the tool bar, such as falloff, specularity, etc. This can be done 
by clicking in the immediate area around the setting you 
wish to minimize. The image here shows the area to click to 
achieve this. 

3.4 Strips Tab
With the help of the Strip menu 
you can select the shape of a 
strip to be applied along the 
drawing trajectory. This may be 
used to draw decorative edges 
or a chain. The red 
X sign means no strip will be 

applied along the trajectory. Just as with pens, you can click on 
the Folder icon to add a new strip.

There are a number of ways that you can apply a strip. You 
can simply brush them in with your pen manually, or you can 
create a spline curve and apply the 
strip to it. Of course, using a spline 
is great for getting an accurate strip, 
so it is recommended you try it with 
a curve first. If it doesn’t suit your 
needs, or you require something 
more “loose,” then you should try to 
manually brush it. It also helps to use 
the Soft Stroke feature when manu-
ally brushing a strip. 

Here you can see an excellent 
image, with the proper use of a strip 
along a spline curve. The bandolier 
around the figure’s shoulders was 
painted with the strip.
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3.5 Masks Tab
Masks are used as a way to specify an area for sculpting or texture 
painting for pen depth and transparency. The idea of a stencil is 
the basic principle. The mask and materials can be moved and 

rotated independently using new navigation controls. Masks and 
materials can be rotated precisely 45 degrees by using Shift.

Pay attention, if you choose to display mask/material in at 
least one of the channels (depths and/or, colors and/or specular, 
see more detail about them below) a new panel shows up on top. 
Using this panel you can manage the Masks/material preview 
parameters:

Hide/Show/Auto. Hide/show/auto-hide full-screen view of tex-
ture. You can switch mode with the hot key “H”. 

Unlock/Lock. Lets you scale and texture automatically while 
scaling and moving the model.

Flip X. Reflect texture, mirror-like, across the horizontal axis.
Flip Y. Reflect texture, mirror-like, across the vertical axis.
Paint. This mode lets you paint with your material or mask.
Distort Image. In this mode you can distort your mask or mate-

rial directly with your brush. You can do some very unique 

texture work with this feature. It is great when you have an 
image that doesn’t match the mesh exactly. You can then 
use this tool to shape the image to match the mesh more 
precisely – so that you can then paint with a material or mask. 
As you can see in the image, the jaw line, nose and silhouette 
of the head have been shaped with the distort image feature.

Reset. Places the texture in its initial position.
Clear/Save/Load Distortion. With these options you can clear, 

save and load your distortions. 
Mapping Method. There are two methods you can use here. 

From Camera and Cube Mapping. From Camera lets you 
project the method through the viewport. If the Cube Map-
ping application type is selected, the material preview will be 
displayed on the pen only, as opposed to full screen (when 
From camera is selected). On the right there is a slider respon-
sible for transparency when viewing the Masks/material.

Opacity of preview. Percentile based opacity controls.

Adding a new mask or material 
is done exactly as you do with 
Pens and Strips.

3.6 Materials Tab 
The Materials menu contains 
three channels: depth, diffuse 
and specular. On each channel 
you can put your own texture. 
By choosing a material and 
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texture you will see the whole 
screen filled with this texture. 
You can add your own materi-
als by choosing the Folder icon 
(material must be in format of 
BMP, DDS, JPEG or TGA). The 
grey X sign means no using of 
the material. Quick-access the 
Materials menu by pressing 

“M” key. Select any material from the list and do some drawing. 
(In the example below, we only want to paint color texture on 
the model, so depth and specular channels are disabled. You can 
enable every channel when needed.)

All of the controls for masks, as detailed in that section, are 
exactly the same for both masks and materials alike.

You can see the power of the Materials in the picture below. 

3.7 Blending tab
This tab contains more parameters then the simple blending 
drop-down list, allowing for more advanced use. Let’s take a look:
Lock transparency. This lets you draw on a Layer without chang-

ing its transparency. Essentially, it lets you edit the current 
colors on a Layer without adding more.

Depth modulator.
Color opacity.
Emboss power.
Contrast.
Brightness.

Specular contrast.
Specular brightness.
Linked Layer. This drop-down list enables you to mask the cur-

rent Layer with another Layer. The transparency and depth 
of the current Layer will be modulated by the selected Layer 
transparency.

Inverse linkage. An inverse Layer opacity will be used as a mask. 
All parameters can be changed, but for this you must change 
values on a corresponding scale. 

3.8 Layers tab
Here we see the list of Layers (Layer 0, Layer 1, etc.), effects with 
Layers and modes of operations with a Layer. By painting on 
multiple Layers and stacking them together, you can achieve 
some very complex-looking texture work. Here you can drag 
and drop Layers to do a number of things, such as to the trash 
can to delete, as well as reordering. You can also rename a Layer 
by double-clicking it. If you know Photoshop’s Layers functions, 
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you already know much of this! Still, let’s take a look at some of 
the parameters in the Layers tab:

Blending dropdown list. This offers a variety of blending modes, 
most of which exactly corresponds to Photoshop’s.

Depth dropdown list. This allows a number of blending options 
between Layers for the depth channel. They are: Add, Sub-
tract, Choose Maximum, Magnify and Supress. You are 
strongly encouraged to try each one out.

Visibility. By clicking on the eyeball you can toggle the visibility 
of a Layer to be on or off.

At the bottom of the Layers tab window we see six icons:

Add new Layer. Add a new Layer. It is automatically made the 
current one.

Delete this Layer.
Merge the current Layer with the lower one. This operation 

cannot be undone.
Duplicate Layer.
Shift the Layer upward. Lifts the selected Layer up.
Shift the Layer downward. Lowers the selected Layer down.

Further more, if you click the rmb on a Layer, more options are 
available:

Layer Blending. Go to the Blending tab.
Duplicate. Duplicate the selected Layer.
Flip Layer and Duplicate and flip. Duplicate the Layer and flip 

it, using topological symmetry.
Flip Layer. Flip the Layer using topological symmetry.
Copy Blue to Red. Copy the blue part of a mesh to the red part. 

You can define blue and red parts in the topological sym-
metry tool.

Copy Red to Blue. Copy the red part of a mesh to the blue one. 
You can define the blue and red parts in the topological sym-
metry tool.

Merge Visible. Merges all visible Layers. “Undo” is unavailable.
Merge Up. Merge this Layer and the upper Layer. “Undo” is not 

available.
Freeze painted pixels. The freeze value will be set equal to the 

Layer’s transparency.
Freeze Transparent Pixels. Freeze the transparent part of the 

Layer. It is important if you want use the transparency mask 
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of the current Layer on another Layer. Use ctrl+lmb on 
the Layer to perform the same action.

Apply Layer Mask. Apply a Layer mask to Layer. The Layer mask 
is a reference to another Layer that masks this Layer.

Apply Blending.
Color to Specular. Transforms color brightness to the specular 

channel.
Invert Color. Inverts the color of this Layer.
Invert Specularity. Inverts the specularity of this Layer.
Fill Unfrozen. Fills the unfrozen parts of the Layer with the cur-

rent color and specularity.
Fill by Mask. Fills the Layer with the current color and specular 

using its current transparency mask.
Set Height to Zero. Sets the height to Zero on all the Layers.
Make Transparent. The Layer will become fully transparent.
Remove Specularity. The specular channel will be set to Zero.

3.9 Sub-Objects Tab
This tab displays all imported 
meshes into a Layer system. If 
you are familiar with the way 
Lightwave deals with Layers, 
then this should be immediate 
apparent in its function. Essen-
tially, each Layer is an object, 
and can be toggled on/off for 
a number of things, like its vis-
ibility or locked/unlocked for 
editing. Or you can also delete 
the object directly in this panel. You can also rename an object 
by double-clicking its name.
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4. Panel Paint Mode
4.1 Per Pixel vs Microvertex
Before we start painting on any meshes, we should discuss some 
of the different methods for painting within 3D-Coat. There are a 
number of them, each with their own positive and negative sides.

The first we’ll talk about is per pixel painting. It was introduced 
into 3D-Coat for the first iteration of version 3. Version 2 used 
microvertex painting. In this latter approach every face (quad 
only allowed) was represented as a patch N×M vertices (N and 
M could be different for every face). Every vertex had color and 
coordinates in space, so every kind of displacement was allowed. 
However this approach was limited because it was very difficult 
to edit meshes with non-quad faces, and projecting a patch to 
texture resulted in a loss of quality, so it was difficult to import a 
texture, edit it and then export because the after-export texture 
appeared to be slightly blurred. So we decided to implement per 
pixel painting. Here are the basic points of this technology:

•	Painting is performed not over vertices but over pixels on 
the texture directly. It looks like every pixel on the texture is 
represented as a point in space.

•	Every pixel contains any number of Layers of color, opacity, 
normal displacement and specularity.

•	Every Layer can be blended with the previous one using 
well-known blending operations for color and displacement.

•	Every texture point in space has its neighbors in a per-pixel 
representation. It is important because it lets you not only 
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paint over the model but also to perform non-local opera-
tions – like blurring and sharpening with brush.

•	Some operations are performed in space, like painting, filling, 
applying curves, some in projection, like smudge. All this is 
transparent to the user.

•	Most operations can be performed (optionally) not only 
on the visible side of an object but on the invisible too, like 
applying curves, filling, painting rings, rectangles and poly-
gons over the surface.

•	Exchange with other applications becomes really fast and 
has no quality loss, so you can use 3D-Coat in any stage of 
the pipeline for a final touch or to perform full texturing.

•	You can import a normal map and use it as a reference for 
texture painting. Normal maps can be changed too, you can 
apply some smoothing (not over seams) or fade some areas.

•	It creates seamless painting and smoothing over textures.

This technology can be used for any kind of texturing – low-poly 
or high poly. You can edit textures from 32×32 to 8192×8192 
pixels large (if you have 1GB or more of video memory). It can 
be used in a very wide range of applications – from graphics 
for mobile phones to high-end game projects and films which 
require huge textures. This technology supports tiled, self-inter-
sected and mirrored textures without any problems. Here is a list 
of the advantages of per-pixel painting over microvertex painting:

•	Much faster then microvertex painting.

•	Supports tiled, self-intersected and mirrored UV-sets (micro-
vertex painting supports only non-overlapped texturing).

•	Takes up less memory than microvertex approach.

•	Gives good precision in painting operations without any 
additional blurring.

The only disadvantage in comparison to microvertex painting is 
that per-pixel painting does not support vector displacement, only 
normal displacement. Sometimes this makes it an essential point, 
so we leaved both approaches in place. For example, using the 
microvertex approach to paint on baked voxel sculptures gives 
you better results. These are the advantages of per pixel painting 
over projection painting:
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•	The possibility of affecting pixels on the back of the model, 
for example filling, blurring and applying overall effects.

•	The painting quality does not depend on the distance from 
the object to camera.

•	More precise painting: what you see is what you get.

The key advantage over the usual texture painting in space is the 
possibility of blurring pixels under the brush – because every 
pixel has neighbors.

4.2 Depth
Before you find out how each tool works in Paint Mode, you 
should know about painting in Depth/Color/Specular channels, 
and also to know about color picking and types of drawing. Point 
the cursor at the purple hued sphere and click. By clicking here 
you can toggle between turning the depth on or off. If there is an 

“X” over the sphere, it will be toggled off. More general informa-
tion about the how the icons on the top bar work is located in 
section 3.3 on page 13. 

The additive drawing option lets you activate/deactivate 
the additive application option when drawing lines. If Additive 
drawing is active, two lines are drawn one over another. Notably, 

if the option is disabled, a cross 
is made with objects drawn in 
the current Layer only. A red 
line on the pen cursor displays 
the depth of relief lying. Press 
the “-” and “+” keys or mouse 

wheel (under corresponding 
adjustments in the Prefer-
ences menu) to see how the 
depth changes. If the pen is of 
complex shape, less pressure 
should be applied to prevent 
steep overfalls of image height. On a side note, it would make it 
hard to present the entire object as normal-mapped low-polyg-
onal one, heavy geometry distortions will be seen.

With the help of “Smoothing” slider you can change the level 
of smoothing. By pressing Shift key green line will appear on 
the pen cursor and by pressing Shift “+” and “ – ” keys or mouse 
wheel (provided corresponding adjustments have been made in 
the “Preferences” menu) you can adjust the level of smoothing.

Pay attention, on the top panel there are inscriptions “Depth”, 
Color”, “Specular”. Point the mouse cursor onto one of them. You 
will see the menu as follows:

Pressing on a the grey “X” sign (first in the list) you will forbid 
changing the correspondent channel when drawing, be it depth, 
diffuse or specular. By choosing the second icon in the list, you 
will enable editing in corresponding channel, however without 
overlaying additional texture in this channel. You will draw with 
a pen not distorted by material. If the texture is chosen there are 
also folder icon and material icon. Pressing the folder icon lets 
you set another texture in corresponding channel for the current 
material. If you set the texture for diffuse channel, bear in mind 
that the texture alpha-channel is used as additional mask when 
laying color.
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Try choosing the first icon in the depth channel and draw a 
little, then opt for a square with texture and draw. The difference 
will be obvious.

To access these menus, press “D” (depth menu), “C” (color 
menu), “R” (specular menu). Use the “~” key to quick-access the 
semi-transparent panel containing the parameters for all the 
three channels in a compact form (you can pin it anywhere in 
your workspace).

On the right is a very good example of the use of depth to 
paint a displacement map (by Juan Carlos Montes).

4.3 Color
Place the cursor to the Color icon. By pressing the grey “X” sign 
you will prevent drawing color for the current texture. By pressing 

on t green sphere icon, you will 
enable editing of the diffuse 
channel, but with no extra tex-
ture overlaid the channel. If the 
texture is selected, you’ll see 
also a folder icon and a texture-

imbued square. Press on the folder icon to replace your texture.
The Transparency slider is the transparency applied to the 

pen color while drawing. You can reduce or increase the transpar-
ency using the hot keys – “О” and “Р” accordingly. You can see 
that, depending on transparency, the segment color changes 
on the pen cursor. The segment acquires a blue color and its size 
depends on the transparency.

Place the cursor on the drop-down list to see the following. 
Here you can determine the rules of color selection for drawing. 
You can draw with a main color, or you can use a mixture of the 
main and background colors:

Use current color. Use the current color to draw.
Use randomly one of two colors. Use one of two colors (current 

or secondary) randomly to 
draw.
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Use random color between two. Use a random mix of two main 
colors.

Here is an example (by Juan Carlos Montes) which uses Color:

4.4 Specularity
Point the cursor on the Specularity icon. By pressing on the red 
sign you will prevent drawing with specularity. By choosing the 
shining sphere icon you will enable drawing in the specular 
channel, but with no additional texture overlaid in the channel. 
The question-mark folder means that no extra specular chan-
nel texture is to be overlaid while drawing has been selected. 
If the texture is selected, the question-mark folder is changed 
into a specular texture square. Press on the folder to replace 
the specular texture for your current material. With the help of 
the Specularity slider you can change the reflective qualities 
which are applied while drawing. The hot keys “<” and “>” or 
mouse wheel (under the corresponding adjustments in the Pref-
erences menu) allow changing the Specular parameter quickly. 
The Opacity of the specularity slider is responsible for changing 
the transparency applied to reflective qualities. The hot keys “:” 
and “/” or mouse wheel (under the corresponding adjustments 
in the “Preferences” menu) provide for decreasing or increasing 
the specular transparency.

Here is an example image with great use of the specular 
painting tools in 3D-Coat (by 
wailingmonkey) below: 

4.5 Color Picker
Now we need to learn how to use the color correctly. For this, 
point the cursor on the “Color” icon on the left tools panel and 
click on a square under the “Color” inscription. By doing so, you 
will see a panel which lets you pick a color. Within this panel are 
further options for other color pickers. You have five different 
color pickers, the last one lets you pick a color from any image 
you load.

This color will paint the square you pointed at. It shows the 
current color. You can choose the second color, too: click on an 
icon right next to the first color icon in The color box (on this pic-
ture the first color is green, the second is black). The second color 
is used in the diffuse channel 
while you work with the drop-
down list. Apart from the stan-
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dard set of color options, the Pick color window contains various 
color selection modes: HSL and IMG (selection from image). For 
the latter, there are additional buttons available.

There are further options for the image color picker panel:

Manipulator Icons. With the icons on the left top of the image 
color picker, you can pan, zoom or reset the position of the 
image.

Select. Select an image from file.
Paste. Paste an image from the clipboard and use it like the cus-

tom picker.
Image Drop-down list. If you have more than one image, you 

can select them from each of these by clicking here in the list.

In addition, for a fast choice of color, you can press and hold 
the “B” key (when calling it this way, you open the downsize 
Pick color window, the same as when calling from the Windows-
>Popups->Color picker. Rmb to disable/enable the use of color. It 
is equivalent to choosing a white color. You can pick color directly 
from a surface, point the cursor on a corresponding place and 
press “V”. You can also pick a color from a color Palette window, 
there are three preset palettes:

Click on the drop-down list (Left), there are 3 preset palettes 
(Middle) , and you can both load and save an .ACO color palette 
file. You can also right-click on a color to change the color’s prop-
erties (Right):

4.6 E-Panel
Place the cursor on the E-Panel menu, here you can see 15 draw-
ing modes available. The first five modes are used with a Wacom 
tablet and most of them are self-explanatory: 
Change pen width and depth. This depends on the pen pres-

sure applied while drawing. 
Depth only. Width remains the same, but depth differs. 
Alter pen radius. This will change the depth and opacity depend-

ing on the pen pressure.
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Droplet mode. Increasing pressure decreases radius and grows 
depth and opacity.

Same width and depth. Ignores pen pressure applied.

The next three modes are drawing with dots, lines and curves: 

Draw with separate dots. This mode lets you draw point by point.
Draw straight lines from point to point. In this and the next 

mode, press esc to start drawing a line from the beginning 
or Ctrl+z to return to the previous point. 

Draw with splines from point to point. The lines and splines 
drawing mode always uses crossing, as opposed to additive 
drawing. This continues until you switch from the line draw-
ing mode into another mode.

The next mode is unique in it’s function and has no other sibling 
modes.

Stamp mode. In this mode the stamp follows the mouse (pen) 
without leaving traces. You can rotate the pen using “(“ and 

“)”keys or mouse wheel (under the corresponding adjust-
ments in the Preferences menu ), change pen size and see 
how the stamp is going to be applied onto an object. We rec-
ommend using the Stamp mode with the Additive drawing 

(located in the depth chan-
nel menu) option disabled.

The concluding five modes are 
all drawing with contours: 

Draw with rectangle. Use a 
rectangle to define the 
drawn area. This mode 
works with almost every 
tool. You can paint, freeze, fill, or make planes with the rect-
angle.

Draw with contour of lines. Press to add points. Press on the ini-
tial point or double-click to finalize the contour. Press esc to 
cancel the contour, bksp to delete the last point. Double-
clicking will close the contour.

Draw with continuous contour. Press lmb to draw a contour. 
Draw with ellipse. Use an ellipse to define the drawn area.
Draw by closed spline/B-spline. Add spline control points with 

the lmb. Press esc to finish. Near the control poins you will 
see a small spline menu button. Press it and you’ll be able to 
choose different options:

Apply. Apply a spline action. 
You may use ENTER instead. 
With ctrl pressed it will 
counteract.

Clear. Clear all control points.
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Detach from surface. This 
command detaches any 
control point that is being 
attached to a surface (a 
control point becomes 
attached if you add it while 
the cursor is over the surface). 

Add points. Use this command if you pressed esc after adding 
control points and then you decided to continue. Press esc to 
finish.

Edit points. This is a default mode after you’ve finished with 
adding control points. Hover over a spline in the place where 
you want to add another control point (when you see a red 
point, press lmb to add it). Drag any control point with lmb. 
Use rmb over any control point to toggle vertex sharpness.

Transform all. Transform the whole spline with the manipulator 
(rotate, move, scale vertically, horizontally, proportionally).

B-Splines. Use B-Splines by default. In this mode the spline will 
be smoother and will not go through the control points. Use 
it with vertex sharpness to get various forms.

Edit points table. Set numerical values of each control point. In 
this window you can also set the type of each control point: 

Sharp (makes sharp corner at this point), B-spline (simple 
spline if unchecked).

Scale. Set the scale factor and press the “OK” button or ENTER. 
Rotate. Set the angle of rotation and press the “OK” button or 

ENTER.
Flip horizontally. Flip the whole spline horizontally.
Flip vertically. Flip the whole spline vertically. 
Save. Save the spline to a file. 
Load. Load a previously saved spline from a file.

There is one final draw mode, it is unique in its function.

Paint over source polygons. This mode lets you fill in whole, 
single polygons.

A few more settings for the E-Panel:

Border width. This slider is 
responsible for the border 
width when drawing with 
the rectangle, ellipse or 
contour.
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Ignore backfaces. This is a switch which toggles between draw-
ing on the back side of surface polygons and not. This option 
is available only when drawing with the rectangle, ellipse or 
contour.

4.7 Paint Tools
While in Paint Mode you can use a set of tools located in the left 
side panel. You can also press Space for quick access (below 
right). Listed below are all of the painting tools in the left panel.

Draw with a pen. The Brush 
icon is the default drawing 
painting method.

Draw with expansion. The 
Airbrush icon is a mode of 
drawing with accumula-

tion. It is highly dependent upon the draw by spots pen 
option.

Color Operations. This tool has 10 different color adjustment 
options. They are:

Desaturate. (color reducing) When you press Ctrl the opposite 
action is performed, and it colorizes.

Saturate. (increment the chromatic level) When you press Ctrl 
the opposite action is performed, and it desaturates.

Darken. (color darkening) When you press Ctrl the opposite 
action is performed, and it lightens.

Lighten. (increment of brightness) When you press Ctrl the 
opposite action is performed and it darkens.

Sharpen. (sharpen the color) Use Ctrl to smooth.
Smoothing. (soft smoothing) Use Ctrl to sharpen the surface.
Increase hue. Increase hue (use Ctrl to decrease hue). The 

transparency determines the degree of hue change.
Decrease hue. Decrease hue (use Ctrl to increase hue). The 

transparency determines the degree of the hue change.
Subst hue. Substitute hue from current color instead of hue in 

current Layer.
Hue&Saturation. Substitute alternate hue and saturation from 

current color instead of hue and saturation in the current 
Layer.

For example, draw on an object using color, then choose the 
Darken command. Draw again on the object in the same place 
to see how your current color darkens. Try different color opera-

27 | 94NewContents Start Right Side Panel Paint Sculpt Retopo UV Mode Voxels Render Menu Hotkeys Customize CUDA FAQ/Tips Credits



tion modes, as this function is highly dependent on the color 
channel’s transparency.

Magnification or reduction of Layer height. Choose the opera-
tions on the Layer height (increase or decrease). When draw-
ing, it is only the current Layer height that is changed. Press 
Ctrl to perform an inverted operation. As with the pen 
shape, so the line and material are taken into account when 
drawing. There are two operations for this tool (holding Ctrl 
will invert their function):

Magnification. The Layer height is increased while drawing.
Reduction. The Layer height is decreased while drawing.
Degree of change slider. This is responsible for the degree of 

height change. 
Shift Layer in tangent space. This tool lets you smudge, col-

lapse and expand the area under your brush. All operations 
will be applied in screen space, so you should try to place 
modified place at the best view position. This tool is intended 
to move only small details over the Layer, so don’t use it to 
move large sections. 
Smudge. Smudges the Layer along motion.
Collapse. Collapses the Layer.
Expand. Expands the Layer.

NOTE: You must click the Lmb to apply the last two operations.

Clone tool. This tool is quite versatile, so please read and test it 
out carefully to learn more about it. Press Ctrl+Lmb to mark 

a source point for copying. Then draw using Lmb. You can 
copy not only with a round pen, but also with the frame and 
contour pen (press “E” for brush types). Additional options 
in the Clone tool menu (Top Left Image). You can clone with 

a number of methods, they are:
Translation. In this mode, 
press Ctrl+Lmb to select the 
source point.
Dx – The horizontal shift of 
source point.
Dy – The vertical shift of 
source point.
Mirroring. Copying with mir-
ror-reflection of a plane. Press 
Ctrl+Lmb to select the point 
for the plane to go through. 
(See below)
Inversion. Copying with inver-
sion against the point. Press 
Ctrl+Lmb to mark the cen-
ter point of inversion: Center 
X and Center Y – positions of 
pivot point on screen. Press 
Ctrl+Lmb in the correspond-
ing places to change it.
Clone sector. Copy a sector 
rotated at a selected angle 
against the pivot point. Press 

28 | 94NewContents Start Right Side Panel Paint Sculpt Retopo UV Mode Voxels Render Menu Hotkeys Customize CUDA FAQ/Tips Credits



Ctrl+Lmb to mark the rota-
tion center point. This mode 
can be used to multiply a pat-
tern drawn in one sector all 
around. Center X and Center Y 
are the positions of the control 
point on the screen. To change 
its position, press Ctrl and 
lmb in corresponding place.
Amount of sectors. Amount of 
sectors when cloning a pattern 
in a sector.
Counter clockwise. When 
enabled, the sector will be cop-
ied counter-clockwise.

Symmetrical copy. Symmetrical copy lets you to copy a surface 
from one side of a model to make it symmetrical. Press “S” 
and activate symmetry before using this tool. This tool can be 
used on any of the three axes to copy symmetry. (Image left)

Copy using pen. This lets you copy using topological symmetry. 
You should set up topological symmetry before using this 
tool. Topological symmetry can be defined in the Topologi-
cal symmetry tool by selecting two symmetrical faces.

Transform/copy tool. Drag the frame and select an area to be 
transferred. The frame acquired can be dragged, or rotated. 
Use Shift to preserve proportions. Use Ctrl to drag vertices 
independently of each other. Press esc to cancel the trans-
formation and enter to apply it. This mode is good to use 

in combination with frame, circle and curve drawing (press 
“E” to open the draw types menu). The border width deter-
mines the edge softness when transforming. By disabling 
channels (depth, diffuse, specular) you can transform the 
remaining channels only. In the transform mode the surface 
area is erased from its old place and copied onto the new one.

In order to simply copy without deleting, do not tick the Erase old 
position option. It is possible to transform whole block of visible 
Layers and paste them merged or separately. You can select what 
to copy not only with a rectangle but also by using the freehand 
selection, drag rectangle, etc. The options for this tool are:

Depth modulator. Additional depth modulator for the trans-
formed area. 

Opacity modulator. Additional opacity for the transformed area. 
Specular modulator. Additional specular modulator for trans-

formed area.
Export. Export to a .psd file.
Import. Import from a .psd file.
Edit. Edit image with an external editor that supports .psd files. 

By default it is Adobe Photoshop.
Save. Save transform parameters and image to InstallDir\User-

Data\StoreData\Rects\
Load. Load transform parameters.
Copy/Paste. You can copy parts of a surface to the clipboard by 

using Ctrl+C and then paste them using Ctrl+V. If the 
cursor is not on an object, it will be pasted to the same place 
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it was copied from. Images in the clipboard can be edited in 
another graphics editor, then copied back to the clipboard 
and pasted onto the object surface. If the color channel is 
open for editing, the color texture is placed into the clipboard; 
if it is disabled, then the depth texture will be placed into the 
clipboard; in case the depth is disabled for editing, then the 
specular texture will be placed there. Hence, you can copy 
and edit in a different graphics editor any of the channels 
depth, color or specular. If you press Ctrl+Shift+C a new 
pen is made from a surface part and added to the pen list. 
When you press Ctrl+Shift+V the mirror reflected part is 
pasted. Bear in mind that copying and pasting are pen-turn 
sensible. Copying and pasting objects with the help of hot 
keys is not limited to Copy/Paste tool, but is possible in any 
other mode.

Save. Save the clipboard image into a file.
Load. Loads the clipboard image from a file. Using these func-

tions, you can create a library of stamps. Load a plane or a 
cube, for example, draw a button or a rivet, then save it to a 
file. As with depth, so the color and specular will be saved, too.

Draw with spline. Upon activating the tool, the Param tab will 
be activated. There are many parameters for the curve tool: 

Curve profile. First let’s take a look at the Curve profiles.

•	Uniform. The curve with no linear modulation.

•	Sharp. The curve 
sharp on edges.

•	Obtuse. (flatten) The curve 
flattened on edges.

•	Arrow. One kind shape of 
arrow. 

•	Arrow back. One kind 
shape of arrow.

•	Double arrow. One kind 
shape of arrow.

•	Arrow. (mod) One kind 
shape of arrow.

•	Back arrow. (mod) One 
kind shape of arrow.

•	Double arrow. (mod) One 
kind shape of arrow.

•	Arrow. (mod1) One kind 
shape of arrow.

•	Back Arrow. (mod1) One 
kind shape of arrow.

•	Double arrow. (mod1) 
One kind shape of arrow.

•	Sinuous. One kind shape 
of arrow.

•	Ignore back faces. When 
this option is activated, you 
draw only on the visible 
part of the surface.

•	Closed curve. Close the 
curve.
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•	Use spacing. Points will be set along curve with some spac-
ing and jittering. It lets you make new effects with curves.

•	Toggle hardness. This mode lets you toggle hardness of the 
vertex in spline by click on he vertex. esc cancels this mode.

•	Profile parameter. This parameter affects the linear curve 
profile in case you selected the sharp or obtuse profile.

•	Depth modulator. Modulator, impacting the entire curve 
depth.

•	Width modulator. Modulator, impacting the entire curve 
width.

•	Opacity. Transform current combination of points to circle 
if possible.

•	To line. Transform the current set of points to a line if possible.

•	Subdivide. Subdivide curve.

•	Equalize. Set equal distances between points.

•	Store. Save curve to a file with *.curve extension, placed into:

•	InstallDir\UserData\StoreData\Curves\ by default.

•	Restore. Load curve from a file with CURV extension, located 
in: InstallDir\UserData\StoreData\Curves\ by default.

•	Moving the whole curve. Use the 3 icons on the right bot-
tom of Params menu; You can rotate/move/scale the entire 
curve. (NOTE: You can use Ctrl and dragging a point to 
rotate the whole curve and you can also use Shift and drag-
ging a point to move the entire curve.)

In order to draw with a spline, we shall determine a spline of sev-
eral points first. When pointing the cursor onto one of the blue 
dots, it gets highlighted. By mouse-clicking you can capture it and 

drag into a new position. Click 
again to release the control 
dot. Splines are handy to use 
together with stripes to care-
fully draw a chain or a string of 
riveting. Click enter to apply 
the spline onto the object. Lmb 
to add new points to the spline. 
Use enter to draw a curve, 
Ctrl+enter to draw a curve 

with inverse depth. Use bksp to delete the last point, esc to 
delete all points.

Curve Profile. There are many curve profiles, you are encouraged 
to test them all out. They range from arrows to rounded ends, 
but of course there are many more.

Use spacing. Points will be set along the curve with some spacing 
and jittering. It lets you make new effects with curves. Curves 
will be drawn correctly, even if their knot points are far from 
each other and the surface between them are quite curved.

With the Draw with spline tool, you are not only able to paint 
and extrude, but you also can:

Erase. Erase the current Layer along the curve.
Freeze. Freeze along the curve. Ctrl+enter to unfreeze.
Planarize. Planarize the surface along the curve.
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Set absolute height. Apply the plane tool along the curve and 
then apply the usual extrusion. It looks like setting the abso-
lute (not relative) depth along the curve.

Placing text along a curve. Using this tool you can select the 
font for text, input the text so as to change the parameters 
of the curve the text is applied along:

Ignore back faces. When this option is activated, you draw only 
on the visible parts of the surface.

Closed curve. Draw a closed curve.
Flip text. Flip the whole text.
Depth modulator. Modulator, impacting the entire curve depth. 
Width modulator. Modulator, impacting the entire curve width.
Opacity modulator. Transform the current set of points to circle 

if possible.
To circle. Transform the current set of points to a circle if possible.
To line. Transform the current set of points to line if possible.
Subdivide. Subdivide the curve.
Equalize. Set an equal distances between the points.
Toggle hardness. This mode lets you toggle the hardness of the 

vertex in a spline by clicking on the vertex. esc cancels this 
mode.
Save. Save text and font in a 
.txt file, placed into InstallDir\
UserData\StoreData\Texts\ by 
default.
Load. Load text from a .txt file, 
located in InstallDir\UserData\
StoreData\Texts\ by default.

Add new points into the spline 
by pressing lmb. Use ENTER to 
apply, with depth, upon apply-

ing the text will be convex over the curve, ctrl+enter for con-
cave. Use bksp to delete the last point, esc to delete all points. 
Click on the blue sphere to move it. With the Putting text on the 
curve tool you are not only able to paint and extrude, but you 
also can Erase/Freeze/Planarize/Set the absolute height. You can 
place text along any polygonal surface and along any contour.
Place picture along spline. You can apply an image along a spline 

curve with this tool. With this tool you can select images used 
for Depth texture/Color texture/Specular texture, put pic-
tures along spline. There are several settings and functions:

Number of tiles. Specify the number of tiles. You can see the 
difference with number of tiles higher or lower:

Falloff. Opacity falloff.
Extrusion. Extrusion of the 

whole texture.

The other parameters are the 
same as in Draw with spline. 
With the Place picture along 
spline tool, you are not only 
able to paint and extrude, but 
you also can Erase/Freeze/
Planarize/Set absolute height. 
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Here is an example of using an image along a spline to freeze 
an area. 

Erase. Erasing the color, depth 
or specularity in the current 
Layer. The range of erasing 
depends on the slider for 
Eraser transparency. Eras-
ing only effects your cur-
rently active Layer.

Hide. Makes selected polygons hidden. To hide the necessary 
parts of a surface, use this command. Pressing a pen hides 
parts of the surface by painting on the model. Pressing with 
ctrl shows previously hidden surface areas. ctrl+”X” to 
unhide all. NUM+ or NUM- makes the hidden area wider or 
narrower.

Hide Parameters. Using the 
additional Hiding menu 

you can save/load hidden areas as presets. In these instances 
you will also have a drop-down list so that you can select 
between these presets.

Hide Menu. Furthermore, you can access the more advanced 
functions of the Hide tool in the main menu in the top tool 
bar. For convenience, you can also undock this menu (like 
any other menu) and place it in an easy to access area. With 
this menu, you are not only able to hide surfaces by paint-
ing on the model, but you also can hide the whole object by 
selecting the object you want to hide. For example, if there 
are several sub-objects in the scene, you can use “Hide Sub-
Object” to hide a specific object, as in the picture below. If 
there are only one object in the scene, Hide Sub-Object will 
hide that object. You can also hide faces by their specific 
material, use Hide Material. Select one material from this 
menu and all the surfaces with that material will be hidden. 

The other commands are self-explanatory.
Freeze Surface tool. This is a mode of freezing surface parts to pre-

vent their subsequent change. 
Freeze mode can be condi-
tional, for example for relief, flat 
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or colored parts depending on 
mode selected. Blocking masks 
the action of feathers. Freeze 
mode is an operation opposite 
to selection. Choose the freeze 
mode and draw on an object. 
Notice that you draw with a 
freeze. Press SHIFT to smooth 
out the edges of blocking. This 
drop-down list provides for 
a surface freeze mode selec-
tion. When the pen goes along 
the surface, it gets blocked in 
accordance with the condition 
you choose in this menu. There 
are five blocking modes in total.
Freeze all. Block with a touch 
of pen or mouse-click (default 
mode).
Convexity. Block the convex 
parts of the surface.

Concavity. Block the concave parts of the surface.
Not key color. Block all, except the color currently selected.
Key color. Block the color currently selected.

There are four sliders on the top bar for the freeze tool:

Contrast. This parameter increases the contrast of freezing.
Details. Level of details when blocking relief parts. When this 

value decreases, the freeze tool will be more sensible to 
details.

Smoothing degree. Sets the smoothing degree.
Freeze degree. Controls the level of the opacity of freezing. 

Blocking can be saved to a file and loaded. In this way you 
can create a set of handy blocking outlines for your model. 
If you saved at least one file, subsequently you will have a 
drop-down list offering a selection of files. Of course you 
can also access many more options for the Freeze tool in the 
main menu of the top tool bar.

Freeze the surface. Freeze all the surfaces with the current con-
dition.

Invert freeze/selection. The frozen surfaces will be unfrozen 
and the surfaces which were not frozen will be frozen.

Toggle freeze view. There are six modes with which you can 
view the frozen area. The difference between each is purely 
visual. Many of the other commands are self-explanatory as 
well, and you are strongly encouraged to explore each one.

Fill. If you are familiar with the fill tool in Photoshop or other 
photo-editing programs, then you should be quite famil-
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iar with this tool already. It lets 
you fill in self-contained areas 
based on a number of param-
eters you can specify. There 
are three main parameters by 
which you can fill:
Layer. Fill the whole Layer.
Material. Fill the material of 
the object.
Object. Fill the sub-object.

There are sub-options for this tool as well, that you can use with 
each of the three main filling methods:

Use color tolerance. This lets you fill in your color or material 
based on its “closeness” to another color. By using the slider 
you can adjust this value. The higher the tolerance, the larger 

area and/or more existing col-
ors it will fill.
Fill with freeze. Instead of a 
color fill-in, the surface will be 
filled by freezing. The Freeze 
degree slider is responsible for 
maximal freeze values.
Lines mode. Lets you fill-in by 
setting two points. The vec-
tor between them is consid-
ered the main direction when 

using distortions. If you 
have chosen the Fill with 
gradient, the surface will 
be filled with color gradi-
ent from the main color to 
secondary one. Otherwise, 
the main color is used for 
filling-in. If the pen radius 
differs in the starting and 
final point of the line, then 
the modulation scale will 
smoothly change from the start to the final point. You can use 
gradient filling in the fill tool in a much more intuitive way.

Modulation type. In case the Use in other tools option is selected, 
the modulation acts not only in the fill-in mode, but with the 
standard pen too. There are are number of basic and user-
adjustable types of modulations available:

Without modulation. Filling will be done without additional 
modulation.

Noise. Random noise.
Gaussian noise. Random modulation with Gaussian noise 

applied.
Wavy surface. Wavy surface y=sin(x).
Strips. Strips that are perpendicular to the main axe.
Saw. Saw-like shape.
Hexagon. A correct hexagonal grid will be used as the volume 

texture when modulating.
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Random spheres. Space filled with random spheres will be used 
as the volume texture when modulating.

Pores. Generation of pore-like surface.
Spots. Generation of “pimpled” surface.
Fractal N1. Volumetric Perlin noise.
Fractal N2. Square of Perlin noise.
Fractal N3. Perlin noise limited by planes.
Fractal N4 (cracks). Resembles cracks.
Fractal wood N1. A set of distorted planes perpendicular to the 

view direction.
Fractal wood N2. A set of distorted cylinders. To set the cylinder 

axe, go into the lines mode.
Fractal tree N3. Wood with knot imitation.
Custom. Rough skin.
Add custom. This lets you create your own custom modulation 

type.

Depending on the modulation chosen in the “Modulation type” 
menu you will have the ability to adjust a number of parameters 
for each one. They are as follows:

Peak position. The position of maximum.
Scale. Scale of modulation.
Anisotropy. The degree of stretching or compression of details 

along the direction selected. If no direction is set, then it is a 
vertical axis. Switch into the lines mode to specify the direc-
tion.

Width of jag. The relative width of jag.

Pores size. 
Spots size.
Cracks width.
Edge contrast. This parameter determines the smoothness of 

the edges in cube mapping.
Bump texture. The bump texture to be used in cube- mapping.
Color texture. The color texture to be used in cube-mapping.
Name. The name of a custom pattern.
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Delete pattern.
Modulate depth. Select this point if you want to modulate the 

depth when filling-in. Parameters: 

•	Depth modulator. Modulation value.

•	Extrusion. The addition extrusion. “-1” means that surface 
will only press in, “1” – only press out.

•	Modulate color. Select the corresponding color operation 
and paint with it. Vary the opacity to make the effect stronger 
or weaker. Parameters: 

•	Color preference. This slider determines the preference of 
color use between color for convexity and concavity.

•	Convexity opacity. Convexity opacity modulator.

•	Convexity color. This color corresponds to convexity.

•	Concavity opacity. Concavity opacity modulator.

•	Concavity color. This color corresponds to concavity.

•	Modulate specular. Select this option if you want to modu-
late specular channel. Parameters:

•	Convexity specular. Convexity specular modulator.

•	Concavity specular. Concavity specular modulator.

To apply the new fill pattern you should specify texture of bump 
and texture of color (optional). 
They will be mapped on object 
using cube mapping with soft 
edges. The screenshot below 
show the difference between 
usual cube mapping and map-
ping with soft edges. In this way 

you can texture objects seamlessly very easily. It is easy to create 
materials like skin or pores.
Save/Load fill parameters. Using menu Store/Restore you can 

store parameters of fill-in to file, located in InstallDir\User-
Data\StoreData\Fillers\ folder by default.

Here are a few things that are worth noting about the Fill tool. 
You are not only able to use Fill tool separately, but also can use 
it in combination with other methods. For example, we can use 
the Fill tool in combination with Material. In the picture below 
we have filled in a certain area with Material, using cubic map-
ping method. On the edges we created freeze areas, while the 
inside area was filled in. Pay attention when lines modes and Fill 
tools are used in combination, you can fill closed spaces with 
color gradient.

Another thing to note is that if your fill area is very large you 
may get a warning prompt from 3D-Coat letting you know that 
it may take a while to fill. If that does happen, please be patient! 
The application may appear to be frozen for a little while.

Eye dropper. Pick the color and specularity from the surface of 
an object. Use the hotkey “V”+lmb to pick the primary color 
and “V”+rmb to pick the secondary color outside this tool. 
Use “H” to pick top Layer. Use “G” to pick depth of pen.

Make planar. This tool flattens the geometry on the object. Use 
the lmb to make the surface inside the pen flat. The pen 
shape is stored. With a call of the “Smoothing command the 
advanced Plane tool menu with a set of options opens: 
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•	Normal source. This option determines if the normal and 
point of the plane should be taken from the first click posi-
tion or from the current point.

•	Plane extrusion. Lets you make additional extrusions while 
making the plane. It works like a clay brush.

•	Make planar. Makes the surface planar.

•	Cut off. Cut off parts over the plane.

•	Fill mode. Fill holes under the plane.
Topological symmetry tool. Topological symmetry lets you 

copy surface pieces if they have symmetrical face structure 
even if they are not symmetrical geometrically. Select the red 
face with left-click and then select the blue face. It is better 
if they are adjacent. Either way, they should be symmetrical 
to each other. This lets you define the topological symmetry. 
The settings for this tool are as follows: 

•	Work mode. Lets you choose between two modes: setup 
symmetry by picking two symmetrical faces or copy from 
one side to another using the pen.

•	Copy red to blue. Copy the red part of mesh to the blue one. 
You should define them before using this tool.

•	Copy blue to red. Copy the blue part of mesh to the red part. 
You should define them before using this tool.

•	Flip Layer. Flip Layer using topological symmetry.

•	Copy freeze mask. This is pretty self-explanatory. It lets you 
copy a freeze mask from one side to another using the topo-
logical symmetry tool.

•	Save. Store symmetry state to .symm file.

•	Load. Restore symmetry state from .symm file.
Measuring tool. This tool lets you measure distance between 

two user specificed locations. Here are the parameters:

•	Original mesh units. You can define the units of measure-
ment and measure line length.

•	Units to display. You should choose the units to display. 
There are parameters in these combo boxes: Meters (m), Mil-
limeters (mm), Centimeters (cm), Kilometers (km), Foots (ft), 
Inches (in), Yards (yr) and Miles (mi).

•	Scale. The scale can be used to transform units. Usually you 
don’t need to enter this value manually.

•	Length. The length of the red line.

38 | 94NewContents Start Right Side Panel Paint Sculpt Retopo UV Mode Voxels Render Menu Hotkeys Customize CUDA FAQ/Tips Credits



5. Sculpt Mode 
The sculpt mode has a number 
of tools to move your mesh 
with some basic deformers. 
This lets you reshape your mesh.

5.1 The tools.
Move. Drag the surface piece. 

Use ctrl to drag along 
the average normal.

Select/Move. Use this mode 
to select surface parts and 
modify them (move, rotate 
or scale). The available 
parameters for this tool are 
as follows:

Select with pen or rectangle. 
Select with pen, rectangle 
or curve. Use ctrl to sub-
tract a selection, SHIFT to 
add a selection.

Select with gradient. Selection is done with a gradient. Click to 
determine the start position of the gradient and then click 
again to determine the end point.

Select objects. Select the whole object with lmb.
Move. Move the selected area.
Rotate. Rotate the selected area.

Scale. Scale the selected area.
Smooth. Smoothe the selec-

tion.
Expand. Expand the selection.
Clear. Clear all selections.
Wide. Make the intermediate 

area of a selection wider.
Contract. Contract the selection.
Increase. Grow the selection value by 10%.
Save. Save the selection to file.
Load. Load a selection from file.

Drag points. In this mode you can add control points and drag 
them (rotation and scaling can be done also). Each point lim-
its the surface modification. Use the delete key to delete 
a selected point. Select several points simultaneously using 
the SHIFT key. The available parameters for this tool are as 
follows:
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Move (Hotkey SHIFT+”W”). Move the selected area.
Rotate (Hotkey SHIFT+”E”). Rotate the selected area.
Scale (Hotkey SHIFT+”R”). Scale the selected area.
Delete all handlers.
Edge hardness. Increase this value if you want to transform more 

hard-edged pieces.
Show selection. Show which selection corresponds to the 

selected point.
Save. Save the handlers positions to file.
Load. Load handlers position from file and add the handlers to 

the existing handlers.
Draw. Draw with pen. Use ctrl to cut into and SHIFT to smooth 

the surface.
Collapse. Collapse a part of the surface. Use ctrl to expand 

the surface.
Expand. Expand a surface part. Use ctrl to collapse.
Shift. Shift the surface along pen motion in screen space.

Tangent Shift. Shift the surface along pen motion in normal 
plane.

Smudge. Smudge along the surface under the pen.
Flatten. Flatten the surface under the pen.
Smooth. Smooth the surface with the pen.
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6. Retopo Mode 
3D-Coat offers the most powerful set of retopology 
tools in the 3D industry. These tools let you quickly 
and easily change the existing topology of a model. 
3D-Coat can be used purely as a retopology tool. 
Just open a reference mesh and start retoplogizing 
it by covering it with new polygons. If the reference 
mesh is textured, 3D-Coat will be able to bake not 
only the geometry but also all texture maps onto 
the new topology.

6.1 Create & Commands
This tool section lets you create a newly retopolo-
gized mesh. Each tool in the retopology section will 
be covered here, as well as most of the commands 
for each tool. 

Add/split. This tool lets you simply add edges by 
pointing and clicking in the location you would 
like to add the edge.

Select. This tool has three pri-
mary modes, allowing you 
to select Points, Edges and 
Polygons. Each of these 
modes has further func-
tions. 

They are as detailed for Points (these are also the general com-
mands for most of the other tools): 

•	Import. This lets you import a mesh for retopologization.

•	Export. This lets you export your retopologized mesh in .obj, 
.lwo, .stl and .ply formats.

•	Snap. This snaps the retopologized mesh to the underlying 
mesh, if you have modified the underlying mesh in anyway.

•	Subdivide. This tool is self-explanatory. It subdivides the 
mesh. For example, each polygon is divided by 4.

•	Clear. This will clear the retopologized mesh in the scene.

•	Relax. This relaxes the current retopologized mesh.

•	Symmetry. This will apply symmetry for the current reto-
pologized mesh, allowing you work on one side of the mesh.

The settings for the Select tool for Edges are as follows:

Spin. Spins the selected edge counter-clockwise.
Spin back. Spins the selected edge clockwise.
Extrude. This will extrude a selection of edges. It can only be 

used on edges on the exterior of the retopologized mesh.
Split. Lets you run an edge loop along a selection of edges.
Delete. Point and click to delete 

edges.
Edge loop. Quickly add an 

edge loop, by hovering 
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over edges to get a preview. Use the lmb and clicking to 
add the edge.

Edge ring. This is the same as Edge loop, however it runs per-
pendicular to the direction of the edge loop function.

And finally we have the Select tool for Polygons:

Delete. Deletes selected polygons. You can also achieve this by 
hovering over a polygon and hitting the Delete key.

Subdivide. This is the same as for polygon mode, or any other 
subdivide option in 3D-Coat.

Hide. This tool makes it easier to retopologize in very tight areas. 
If you are running into a problem, simply select the polygons 
in question, and hit the hide button.

Invert hidden. This will invert the polygons you may have previ-
ously hidden.

Unhide. This will unhide all 
polygons previously hid-
den.

Quads. The basic use of this 
tool lets you select an edge 
of a polygon, and then drag 
out and click the placement of the edges for a new polygon. 
There are four different methods of use for this tool, and they 
are are fairly similar. You are encouraged to try each one. They 
are: 2-clicks method, Parallel, Direct and Trapezoid.

Points & Faces. This method is quite handy when starting out 
on your retopologization. You place points with the lmb, 

and once there are qualifying 
areas to place polygons, you 
only need to use the rmb to 
place the polygons. You will 
see a blue outline of where the 

polygon will be placed. You can move the points by using 
the rmb to click and drag it around. You can also delete a 
point by hovering over it and hitting the Delete key. This 
tool will only work with tris and quads.

Cap. With this you can cap any existing hole in your polygonal 

mesh by pressing the rmb 
over it. It will create trian-
gles only. It is best used for 
the end of a pointy object, 
such as the tip of a sword 
or spear, pointy ears or tails.

Strokes. This is a very powerful 
tool in the retopology arse-
nal. With it you can quickly 
retopologize cylindrical 
objects such as arms, legs 
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and other similar items. You can draw lines by clicking and 
dragging the lmb. There are a few commands local to this 

tool:
Clear. Clear all the drawn lines.

Smooth. Smooth all current 
drawn lines.
Delete. Delete your currently 
selected line.

Here is a more in depth look 

at it all. Firstly we’ll start by 
making some strokes in the 
viewport to cover the whole 
of this leg. When that is done, 
a spline will loop around. We’ll 

create a few loops to have some area to create polygons in.
Next we’ll create a perpendicular line within the confines of 

the area of the mesh, opposed to the previous lines. You’ll notice 

that line is a green color instead 
of orange.

Green lines mean that it is 
discontinuous. Orange lines 
mean that is is continuous and 
makes a full loop around to con-
nect back to itself. Now let us 
take a look on the top toolbar, 
we’ll need to select a number of 
segments. You will get ring of 
polygons with corresponding 
number of segments. Now we’ll 
try something a little different: 
instead of drawing lines around 

a mesh, let us draw a grid look within the mesh, instead of slices 
as before. Now press the Enter key and you will have the area 
you surrounded with the strokes created as polygons.
Now let’s demonstrate one more method here. We’re going to 
draw a circle within the confines of the mesh, to create edge loops, 
or circles. Then we’ll draw a perpendicular stroke to the circles 
that we previously created and 
then hit the ENTER key. You’ll 
notice that it automatically cre-
ated our entire loop based on 
the Number of segments set-
ting in the top tool bar, similar 
as before with the first demon-
stration we gave for cylindri-
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cal objects. These are just some of the methods with this tool that 
you’ll soon discover. You are encouraged, as with all other tools 
in 3D-Coat, to dive in and find out what tools and techniques 
work best for you.
Brush. This tool lets you move vertices based on your brush size 

and intensity, using the lmb. You can also smooth the ver-

tices with your brush using SHIFT+lmb.

6.2 Tweak & Commands
This set of retopology tools lets you tweak the current retopolo-
gized mesh in the viewport. Please notice that the commands for 
each tool in this Tweak section have very similar commands to 
those listed above in the Create & Commands section. If there 
is a unique command, it will be listed with its respective tool.

Delete polygons. You can delete polygons with this tool simply 
by clicking them. With the ctrl key you can also delete all 
connected polygons.

Delete edges. With this you can quickly delete edges, edge loops 
and edge rings. Hover your mouse over the desired selection 
and click the lmb.

Collapse. Hover your mouse over a selected edge and click 
the lmb to collapse all connected points of that edge to one 
location. With ctrl+lmb to apply this to an entire edge ring.

Split rings. This is exclusively an edge loop tool. Hover the cur-
sor over an edge where you would like to apply a new edge 
loop and click your lmb.

Move vertices. Also known as a “tweak tool” in some packages, 
it lets you quickly move a point, edge, polygon, edge loop 
or edge ring. Select the mode you would like to use in the 
top tool bar, size your brush accordingly and move around 
your selection.

Slide edges. Slide a selected edge between its two parallel 
edges by clicking the lmb and dragging.

6.3 UV
Mark Seams. When you are ready to unwrap your mesh to cre-

ate a UV map, you must first select your seams. That is where 
this tool comes in. You can select edges with the lmb, edge 
loops with SHIFT+lmb and deselect with ctrl+lmb.

Edge loops. This tool is no different from holding down 
SHIFT+lmb with the Mark seams tool. The difference here 
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is that you are not required to hold down the SHIFT key to 
select your desired edge loops.

Clear clusters. Clears all UV clusters (also called UV islands) and 
seams.

Clear seams. Clears only the seams of the current mesh.
Auto seams. This function is almost self-explanatory. It will create 

seams automatically with a “best guess” about which edges 
to select for seams.

Unwrap. Fits all clusters into the UV space.
Pack UV. Packs all unwrapped UV clusters onto the UV map. When 

this operation is complete, you can edit the islands on the UV 
map. You can then perform many essential functions which 
require a UV map.

Save/Load. You can save and load the seam and cluster informa-
tion of the current scene so it can be edited later. Note that 
this does not export or import a UV map.

More advanced tools for editing 
your UV maps directly reside 
in the Selected portion of the 
retopology tools. These tools 
all require a selection in the 
UV Preview window. To select 
a cluster (or island) simply click 
on one with the lmb.
Rotate CW. Rotate the selected 
island clock-wise.

Rotate CCW. Rotate the selected island counter clock-wise.
Flip U. Flip the U of the UV map.
Flip U. Flip the V of the UV map.
Strict. Applies a light smoothing across the selected cluster (or 

island) to relieve stretching or pinching.

6.4 Retopo Menu & Tool Bar
Of course any good tool has more to it then meets the eye. The 
retopology tools are no exception. You can find the menu in the 
top tool bar, under Retopo. Below are listed all of the functions 
in this menu.

Import retopo mesh. Import an external mesh to continue a 
retopologization started in another 3D modeling program.

Export raw object. Export a retopo mesh to continue work in 
another 3D-modeling program.

Use current low-poly mesh. A reference mesh can be imported 
to retopologize big objects made in another 3D modeling 
program. They can contain reference to textures. In this case 
the objects will be colored; color will be used in baking and 
merging into the scene.

Unwrap. The same as Unwrap in Mark seams mode.
Clear mesh. Clear the whole mesh.
Subdivide. Subdivide the whole mesh.
Apply symmetry. Apply symmetrical mirroring.
Merge into scene. Lets you merge a retopologized mesh into 

scene. All details from the reference mesh will be baked into 
a new object. Additional extrusion can also be applied. A UV-
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set is required, but if you have not assigned a UV-set it will 
be generated automatically.

Merge hull in scene. Merges outer mesh over reference object 
into scene. This function works like Merge into scene but is 
optimized for a multi-object reference mesh. It prefers outer 
points while baking surface.

Merge raw patch. Merge a raw patch into the scene. No baking 
will be performed. This command can be used to merge a 
new object without projecting details from the reference 
mesh.

Merge for per pixel painting. 
Replace scene with patch.
Bake texture. Bake texture onto patch. This operation requires 

a UV-set.
Save retopology state.

Load retopology state.

And we have these items in the top tool 
bar for the Retopo tab:

Z-bias. Adjust the z-bias to get a better 
look at the retopologized mesh pre-
view.

Additional extrusion. You can extrude 
the retopologized mesh. This is a 
great way to make clothing for your 
characters.

6.5 Retopology 
Groups (Layers)
3D-Coat has a Layer system for retopolo-
gizing meshes. This makes it easier to retopologize your meshes 
with problem areas and to have multiple retopology versions of 
the same object. Much like all the other Layer tabs in 3D-Coat, 
they function like the Layers in Photohop. You can click and drag 
Layers to reorder them, drag them to the Trash icon to delete 
them, hide & show them with the Visibility icon, etc. Let’s take a 
look at the Retopo Layer tab.

Layers. As you see in the screenshot, you can have more then 
one Layer to retopologize, if you wish. They can be reordered 
by drag and drop, they can be dragged to the trash if you 
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no longer need one. Double-clicking a Layer will allow you 
to rename it.

Visibility. Each Layer has its own visibility icon, allowing you to 
toggle them on or off.

There are icons along the bottom of the tab as well, and they are:

New Layer.
Trash can.
Subdivide. Lets you to subdivide the whole selected Layer.
Symmetry copy. Copies an 

entire Layer symmetrically. 
Symmetry must be active 
for this to work.

Select all faces. Selects all 
polygon faces of the cur-
rent Layer.

Move selected faces to cur-
rent Layer.

Delete Layer. This will delete 
your currently active Layer.
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7. UV Mode 
In 3D-Coat version 3.2, the UV tools have undergone a very seri-
ous change! You can now edit not just islands in this mode, but 
also polygons, edges and vertices themselves. There is also now 
a brush mode, so you can tweak your UVs to your liking with a 
brush, allowing for smoothing and other quick manual UVs. You 
may have noticed that some of the tools covered in this section 
are also in the Retopo mode section but do be aware that there 
are some unique tools to this mode and unique information, so 
please don’t skip it! They are important for use of the UV tools 
in 3D-Coat.

You can now specify which unwrapping algorithm you wish 
to use. There is the older LSCM unwrapping, and the newer ABF++ 
unwrapping. When you mark a new seam 3DC unwraps new 

clusters in real-time and shows you the preview of unwrapped 
clusters immediately, so that you can see the degree of distortion 
for every part. You can see new clusters appearing in real-time, 
lest you should forget some seam before unwrapping.

7.1 Modes
Add clusters. Click the lmb to 

add a cluster center directly 
on a polygon face. Clicking 
again on the same face will 
remove it. This tool lets 
you “mark” a seam without 
actually marking it as one, 
allowing for a whole UV 
island to be split into parts 
without actually splitting 
them.

Mark Seams. When you are 
ready to unwrap your mesh to create a UV map, you must 
first of course select your seams. That is where this tool 
comes in. You can select edges with the lmb, edge loops 
with SHIFT+lmb and deselect with ctrl+lmb.

Edge loops. This tool is no different then holding down 
SHIFT+lmb with the “Mark seams” tool. The difference here 
is that you are not required to hold down the SHIFT key to 
select your desired edge loops.
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7.2 Commands
Clear clusters. Clears all UV clusters (also called UV islands) and 

seams.
Clear seams. Clears only the seams of the current mesh.
Auto seams. This function is mostly self-explanatory. It will 

essentially create seams automatically with a “best guess” on 
what edges to select as the seams.

Unwrap. Fits all clusters into the UV space.
Pack UV. This will pack all unwrapped UV clusters onto the UV 

map. When this operation is complete, you can then edit the 
islands on the UV map. At this point you can perform many 
essential functions which require a UV map.

Update Islands. When you have an existing island, and further 
mark a seam on that island causing it to become two, you 
will need to perform the Upd. Islands command to carry that 
information to the UV Preview Tab so that you will then have 
those two UV islands selectable, in the UV Preview Tab.

Apply UV-set. Clicking this will apply the currently defined UV 
set to the current mesh.

Save/Load. You can also save and load seam and cluster informa-
tion of the current scene so it can be edited later. Note that 
this does NOT export or import a UV map.

Further advanced tools for editing your UV maps directly reside 
in the “Selected” portion of the of the retopology tools. These 
tools all require a selection in the UV Preview window. To select 
a cluster (or island) simply click on one with the lmb.

7.3 Selected (General)
Clear. Clears the selection.
 Invert. inverts the selection.
Rotate CW. This will rotate the selected island clock-wise.
Rotate CCW. This will rotate the selected island counter clock-

wise.
Flip U. This will flip the U of the UV map.
Flip V. This will flip the V of the UV map.
Relax (or Strict). Applies a light smoothing across the selected 

cluster (or island) to relieve stretching or pinching.
UV Preview Tab. Inside of the UV preview window you can 

also manipulate your UV islands & more directly. By clicking 
the lmb on an island, you’ll then see a manipulator gizmo. 
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Selected islands will then highlight all edges of it’s respective 
polygons inside the 3D viewport.

UV Preview Manipulator. This manipulator lets you scale, stretch, 
rotate and translate whichever cluster you currently have 
selected. You can manually place your clusters as you see 
fit before packing them into a UV map. You must have the 

“Manipulator” tick box turned on to use this. It can be used 
Vertice, Edge, Poly & Island modes.

In block Selected you will find a set of commands that are 
related to the selections made in the UV preview window. After 
applying the Unwrap command you may want to edit UV island 
in the UV preview window.

On the top panel you can choose selection types: Vertices, 
Edges, Faces, Islands, Brush and Tweak. Select vertices, edges or 
faces (depend on what type have you chosen) with lmb. If you 
hold lmb and drag the mouse you can select several vertices/

edges/faces. Use SHIFT to add an item to selection, use ctrl 
to subtract an item from selection. Depending on selection type 
operations in the Selected block may change.

Vertices Mode. Lets you Clear, 
Invert, Rotate CW, Rotate CCW, 
Flip U, Flip V and Relax.
Edges Mode. In Edges selec-
tion mode there are a few new 
tools. They are: To line, Equidis-
tant, Horizontal, Vertical.

The following tools are for 
edges mode:
Select Edge Loop. You can 
select an edge loop by double-
clicking on an edge or you may 
simply use an Edgeloop com-
mand in the Selected block. 
With Edgering command you 
can select edge rings.
 To Line. This command places 
all selected edges along the 
line.
Equidistant. This command 
places all selected edges along 
the line and sets equal distance 
between points.

50 | 94NewContents Start Right Side Panel Paint Sculpt Retopo UV Mode Voxels Render Menu Hotkeys Customize CUDA FAQ/Tips Credits



 Horizontal. This command puts all selected edges horizontally.
 Vertical. This command puts all selected edges vertically.
Set seams. This command marks selected edges as seams.
 Del seams. This command unmarks selected seams if there are 

such.
Faces Mode. This selection mode differs from Vertices selec-

tion mode in four additional commands: Hide, Inv. Hidden, 
Unhide, Unhide all. Use this commands to show only selected 
faces in the viewport. All other commands work the same 
as for Vertices.

Islands Mode. This selection mode lets you operate with sepa-
rate UV islands. You can translate, rotate and scale (vertically, 
horizontally and proportionally) an island with the help of 
Manipulator.
Note: that you need to acti-

vate the manipulator on the top 
bar. Check the Select and Manipulate check-boxes. Also, Keep the 
Select check-box always checked unless you don’t want to select 
anything.
Unwrapping Methods. These commands are important, as any 

mesh you create will need to be unwrapped if you wish to 
paint a texture, or do any such work. The are:

ABF (Angle Based Flattening). ABF is a newer one and is used 
for better used for organic meshes. 

LSCM (Least Squares Conformal Maps). Meshes in 3D-Coat are 
unwrapping with LSCM by default. This method is also used 
for organic meshes, but unwraps inorganic meshes quite 
well too.

Planar. This projects across the arbitrary axis, so you may use it 
if you need.

Brushes mode. In this mode you operate with the brush which 
size and be changed by holding rmb pressed and moving 
the mouse aside. With the lmb click and drag you can manip-
ulate the mesh under brush. Use SHIFT+lmb to smooth the 
mesh. Use ctrl+lmb to pinch the area under the brush. 
Use SHIFT+ctrl+lmb to expand the area under the brush.

Tweak. It lets you drag vertices, edges or faces around in a very 
easy way. Simply move the cursor over a vertex/edge/face 
until it becomes highlighted and then drag it with lmb.

Checker Options. The mesh can be displayed in one of three 
ways: with no checker, with simple checker, with complex 
checker.

Multi-UV Support. Another drop-down list on the left of the top 
bar is Choose a UV-set list. If the mesh has a multiple UVs you 
can switch them in that drop-down list.

Overlapping UVs. You can 
have overlapping UVs 
within 3D-Coat with no 
problems occurring.
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8. Voxels Mode 
8.1 What are Voxels?
Almost all other 3D-sculpting programs are polygon-based, which 
means that they work only with the surface of 3D objects – they 
manipulate a “skin” which has no thickness. But voxel-based sculpt-
ing programs work with the volume of 3D objects – they manipu-
late a kind of “solid mass”. This approach lets you sculpt without 
any topological constraints: it lets you build up complex objects 
from “nothing” and to endlessly add and subtract volume “mass” 

– and easily punch holes in the objects. This approach gives you 
total freedom in your 3D sculpting. With voxels, you can work like 
an old-fashioned, real-world, clay-based sculptor – one who never 
needs to think about dreary technical things like polygons and topol-
ogy and who therefore can just freely and easily express himself. 
If you need to sculpt an ear, an arm, or a leg, simply start putting 
together lumps of digital clay!

So what are these voxels, anyway? The word “voxel“ itself is a 
contraction of “volumetric pixel.“ Mathemati-
cally, voxels are numerical values [0..1] placed 
in a cubic grid. The object’s surface is located 
where the value is equal to 0.5. The picture on 
the upper left illustrates this principle. 

In summary, voxels are points in 3D space 
that contain information on volume and color. 

Great as voxels are, you should also under-
stand some of the limitations of this technol-
ogy. For instance, objects can’t be too thin in 

a voxel form. If you want to make a very thin surface, like cloth, 
you should increase the resolution of the voxel object – or use 
the new Surface mode for voxels. This can be done by clicking 
on the Cube icon next to the particular Layer you would like to 
work on – and it will then change to a wavy line. The wavy line 
represents the Surface mode.

8.2 Volume Sculpting Tools
When you’re in Voxel Mode there is a robust set of tools that you 
can use for sculpting and to perform different operations. They 
are located on the left-side tool 
panel. You can always call the 
tools panel by pressing space 
anywhere on the screen. As 
with any other panel, you can 
pin it for your convience.
Increase.  Increases or 

decreases the surface 
beneath the cursor. None 
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of the pens having any effect on it – just the brush size and 
the intensity. Press lmb and move the mouse to increase. 
ctrl+rmb to decrease. On the top panel, the Growth power 
controls the intensity of the increase and the Thaw power 
controls the intensity of the decrease.

Fill. Fills any cavities that you apply the brush to. It’s useful 
when you want to make cavities less deep but not fully level 
with the rest of the surface. It sometimes requires very high 
intensity settings to fill areas.

Clay. Lets you place strokes quickly onto your voxel sculpt. 
It will also simultaneously smooth the surface after you’ve 
brushed it (as does the carve tool).

Carve. Lets you place high peaks and deep gauges quickly on 
your mesh, but with no smoothing.

Airbrush. This tool is great for very quickly placing horns and 
other protruding elements. Unlike the Airbrush, the Increase 
and the Clay tool, it constantly grows underneath your brush 
as you press the lmb, regardless of forward motion.

Build. This tool is similar to the Increase and the Airbrush tool. 
But while the Airbrush will continue to build while holding 
down your cursor, Build doesn’t do that. You have to move 
it, like the Increase brush. However, with the Build tool you 
can use alpha pens – and it doesn’t smooth.

Extrude. This tool is very similar to the Carve tool, but it is also 
strongly smoothed.
Sphere. This tool is a very quick 
way to create bubbles, bodies, 
etc. The size of the sphere is 

dependent on the size of the brush. You can also make it 
dependent on the pressure: click on the icon near the Sphere 
extrusion slider. The maximum size will be the maximum 
size of the brush. You can create separate spheres and long, 

“pill-shaped” cylinders rounded at the ends.
2D-Paint. This tool paints on two axes which you specify by right-

clicking anywhere. Notice first that, as you rotate the view 
and move the brush, it’s moving along the two axes. When 
you change it, it will always face the camera. Pick any pen 
you like and just draw! It also has an important option on the 
top tool bar: Double sided. With this checked you can paint 
double-sided strokes.

Planar. This tool, new in version 3.2, acts just like a carpenter’s 
wood plane does. It will scrape the volume from the set set 
position & normal of the brush cursor. You set the brush cur-
sor’s position & normal by clicking and holding the rmb and 
then dragging along the surface of a voxel object. There are 
five modes by which you decide the position of the brush: 

Pick point & forward direction. This will place the cursor at the 
last location you used the rmb, facing toward the camera.

53 | 94NewContents Start Right Side Panel Paint Sculpt Retopo UV Mode Voxels Render Menu Hotkeys Customize CUDA FAQ/Tips Credits



Pick point only. This will place 
the cursor at the last loca-
tion you used the rmb only. 
Its direction is based on the 
settings in the parameters 
tab.

Pick point & direction. This will place the cursor at the last loca-
tion you used the rmb, and its direction will be based on the 
average normals of the voxels that your brush covers.

Pick point & direction (local). This will place the cursor at the last 
location you used the rmb, and its direction will be based 
on the single normal of the voxel your brush is centered on.

Navigate. Lets you navigate the viewport. This can also be done 
while holding the ALT key.

Now we’ll continue with the 
other tools:

Scrape. This tool is not affected 
by pens, just the Size of the 
brush and the Intensity. It’s 

very similar to the Flatten 
tool: it flattens the surface 
beneath the brush.

Vox pinch. This is great for mak-
ing very nice tight edges, 
cavities and peaks. You can better see that on the pictures 
below. 

Vox follow. This tool drags the surface topology along with the 
brush. It’s great for producing wrinkles on a character or a 
piece of clothing.

8.3 Adjustment Tools
Pose tool. This tool is great for quickly changing the rotation, 

scale and translation of a selection. You can determine the 
selection in several ways. You can use a line, ring, sphere – and 
you can even paint on it with a pen or an object. Check the 
Airbrush mode when using Select with pen to increase the 
selection area smoothly. After a selection is made, a special 
posing gizmo will appear. It has three states: Rotate, Scale 
and Translate. You can switch modes by clicking on the long 
red rectangular bar at the base of the gizmo. In each state the 
gizmo has set of parameters in the Params window. Finally, 
as with all tools in 3D-Coat, the pose tool respects symmetry, 
as well as all selection modes, like drag rectangle, lasso, etc.

Let’s now take a look at some of the pose tool parameters:

54 | 94NewContents Start Right Side Panel Paint Sculpt Retopo UV Mode Voxels Render Menu Hotkeys Customize CUDA FAQ/Tips Credits



Line. This mode lets you draw a line-based gradient for use with 
the pose tool gizmo. It starts with your initial lmb click and 
ends with the release of the lmb.

Ring. This selects a ring-based gradient. It starts with your initial 
lmb click and ends with the release of the lmb.

Sphere. This selects a spherical gradient. It starts with your initial 
lmb click and ends with the release of the lmb.

Select with pen. Selecting with pen mode lets you directly brush 
on your selection. The pen size directly affects the selection 
area. Furthermore, you can also smooth your selected area 
by holding SHIFT+lmb. This is a great way to select things 
quickly if you just need tiny little details selected. This mode 
also has a special option, Airbrush mode. By using airbrush 
mode you can also smoothly selected areas instead of hav-
ing a hard edged selection. It makes for tidy deformations 
around the edges of your selection.

Special note for Select with pen: This is worth mentioning twice, 
as it is very useful. With the Pose tool, you can use almost any of 
the selection methods in the Pen mode bar, like drag rectangle, 
lasso, etc. You can also subtract your selection by using the tool 
normal while holding the ctrl key.

Object. If you have multiple objects in your vox tree, this mode 
can come in very handy. Simply click on the object you want 
to deform using the Pose tool and it will place the entire 
volume as your selection.

Move. With this tool you can literally move the surface area within 
your cursor. Press and drag lmb to move the surface within 
the cursor, relative to the screen view. Use ctrl to move the 
surface along the normal. It also works with the alphas of a 
pen – so then different alphas give different result.

Hide. This tool has undergone a massive change. You can now 
hide on a per voxel basis. This lets you the sculpt with your 
brush the areas you wish to hide, while it also respects other 
selection methods, like drag rectangle, drawn contours, etc. 
This new method of hiding makes it much easier to create all 
hard edged surfaces for objects. The tool also has a few other 
functions, which you will find in the Voxel menu. They are:

Unhide all. Unhides any hidden voxels.
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Invert hidden. Inverts hidden voxels.
Delete hidden part. Deletes any voxels you have hidden.
Separate hidden part. Creates a new Layer in the vox tree and 

places the previously hidden voxels into the newly created 
Layer.

To continue with the other tools, they are:

Cell Hide. This hides “cells” of voxels based on your brush size. 
Unlike the other Hide tool, it does not allow sculpting or 
seperating hidden parts to create seams and other objects.

Copy. To use this you must have two Layers in the vox tree. It is 
preferable if one of the Layers is empty, but it doesn’t need 
to be. In your other Layer there must be a portion of a vol-
ume object you wish to copy: with this Layer visible and 
your empty Layer active, you can brush along the surface of 
the background object. This will copy the brushed areas to 
the previously empty Layer. It is a really quick way to create 
objects based on a character’s surface topology, like body 
armor, clothing, etc.

Transform. This tool lets you rotate, scale and transform your cur-
rently selected Layer. By grabbing one of the gizmo handles 
you can constrain to whatever axis you clicked on. You can 

also perform a screen-based rotation using the large outer 
circle. A few of the other options for this tool are:

Move only gizmo. Lets you make adjustments exclusively to 
the gizmo. This helps when you need to place the gizmo in 
another location.

Leave rotated axis. This is great for when you need to rotate an 
object multiple times while retaining its previous rotations.

Position & Axes (1,2 & 3). These parameters let you manually 
key in the position and rotational coordinates.

Scale (X, Y & Z). These parameters allow you the manually key 
in scalar modulations.

Reset axis/space. These two functions let you reset an object’s 
axis or local space.

Wrap. You’ll find this tool is quite versatile! It lets you twist and 
bend the currently selected object Layer in the VoxTree. This 
is very important: each function of each of the WrapType’s 
will alter any of the other types end functions. So you are 
strongly encouraged to test this tool out, to find out what 
best works for you. That said, the following descriptions are 
based on the use of a default sphere, so let’s take a look:

WrapType. Drop-down list with two methods: Bend and Twist. 
Bend will bend or wrap the current Layer around the base of 
the gizmo. Twist will rotate the current Layer around its pole. 
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The following functions are for the Bend type:

Segments count. Increases the number of segments.
Start/Final angle. Adjusts the begining and end of the wrap.
FowardStep. Create a “spiral staircase” look: it will literally spiral 

the object upward.
Overlap. This tapers each segment where they meet. The effect 

will vary depending on the object. 

The following functions are for the Twist type:

Segments count. Increases the amount of segments.
Twist angle. Twists the current object around the gizmo.
Overlap. Tapers each segment where they meet each other, 

simultaneously increasing/decreasing the space between 
each spiral.

Axial symmetry. This tool lets you clone the active Layer from 
the Vox Tree with axial symmetry. You can set the number of 
copies in the Params tab. The gizmo works just like all the 
other gizmos. Move the translate handler (octahedron-like) 
to get an idea of similar things you can do with it. You are 
strongly encouraged to explore this tool’s possibilities.

Barelief. This looks at the exist-
ing volume of an object, 
and extrudes to create new 
volume based on the posi-
tion of the gizmo. The area 
at the base (sphere) of the 
gizmo from the tip is the 
area that will be affected. 

It is great for creating coins and jewelry. 

8.4 Object Tools
Logo. The logo tool lets you import any black and white picture 

and convert it to voxels. You can convert images that are in 
the .bmp, .tga, .jpeg and .png formats. Click on the Logo 
tool and select an image. When imported, voxels will be cre-
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ated on the basis of grayscale image. It will default to the 
merge tool, so you can use the standard merge gizmo here.

Cut&Clone. This tool will let you cut and clone the volume of 
a voxel object based on the type of brush parameters. It 
defaults to the drag rectangle pen mode and will copy the 
whole volume of the object underneath. You can also adjust 
your border parameters with three different types: Round, 
Plane and Sharp.

Split. This tool is very similar to the Cut&Clone tool. It has the 
exact same border settings. The difference is that it tears a 
chunk of the object that you are operating on and creates 
its own object Layer in the VoxTree.

Merge. This tool lets you import polygonal meshes to convert 
into voxels. Let us first go over some of the basic functions 
of this tool:

Select mesh. Selects a mesh stored on your hard drive.
Pick from retopo. If you have something retopologized in the 

Retopo tab, then you can use the mesh to merge to voxels.
On pen. Turns any merged mesh into a pen to sculpt with. (Note: 

If you are using a high-res object and then click that, you’ll 
be painting high-res objects all over, which will cause a lot 
of lagging.)

Subdivide. Subdivides your un-merged mesh.
Transform. Will change to the transform gizmo, allowing you to 

transform the un-merged mesh.
Shift (X, Y & Z). Shifts the un-merged mesh along the selected 

axis inside a bounding box in local space.

Presets. This tool has a number 
of presets, you are encour-
aged to explore them.

Some of the more advanced 
functions of this tool are:

Merge separate volumes. 
Merges each sub-object to its own unique Layer in the Vox-
Tree.

Respect negative volumes. If an un-merged object has “_nega-
tive” somewhere for a sub-object inside the file, this function 
will subtract this volume when merging it with other sub-
objects. You should know in advance when you are going 
to use this feature, as “_negative” is a prerequisite. It is great 
for creating greebles and nurnies.

Let’s take a more detailed look at this feature. (Thanks to our users 
Tinker and Daniel Yarmak for the descriptions).

Greebles or nurnies can 
be created in any 3D model-
ing application, usually with a 
series of arbitrary extrusions. To 
make your models look more 
interesting and unique you 
would probably want to create 
your own greebles. Details with 
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angled surface look better than surfaces all-parallel. For easier 
placement of details on a model, create a contour for the detail 

– an object with the name “_negative” which subtracts automati-
cally from the model and leaves a slot for the detail. It’s important 
to turn on Respect negative volume in the Merge Params tab to 
permit contour exclusion. Because the “negative volume” width is 
larger than width of the detail, we get an interesting effect. There 
is a joint between the body and the object. Load the greebles 

using the Merge tool. Use the On pen mode and the “9” and “0” 
keys to rotate the brush.
Sketch. This new tool is a very important addition the the toolset. 

It lets you create a volume object with 2 or 3 images – if you 
use 3 images, the voxel object will be more detailed. Please 
try this new tool out, it is great for creating basic shapes for a 
more detailed objects very quickly. This tool has a few opera-
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tions, all of which are self-explanatory – please explore the 
options for this tool.

Curves. The Curves tool is easily one of the most powerful tools 
in the voxel arsenal, as it lets you place spline points directly 
into your scene with the lmb.To edit an existing point, sim-
ply click with the lmb. To escape from editing a point, hit 
your esc key. This tool also uses a gizmo for transformations. 
The arrows will translate, the boxes will scale or stretch, the 
inner white ring will translate on all axes. When using the 
function Apply to whole curve there will be an outer white 
ring which allows for viewport based rotations. In addition 
to the standard curve tools described above, there are now 
4 modes:

Extrude. Lets you extrude new hierarchies from the existing point 
of a curve. Simply click and hold the lmb, then drag in the 
direction you want to create the extrusion. Holding SHIFT 
will default to the new Rotate mode. It can also be activated 
with the “Q” key.

Move. Lets you move points of a curve individually. Adding the 
SHIFT key will move its child or parent hierarchy, depend-
ing on the direction of the manipulator arrow. It can also be 
activated with the “W” key.

Rotate. Lets you rotate the child or parent hierarchy of a point 
with viewport based rotations. It can also be activated with 
the “R” key.

Scale. Lets you scale the child or parent hierarchy of a point. It 
can also be activated with the “E” key.

NOTE: You need to click the lmb to edit a point, esc to stop 
editing a point. When using one of the four new edit modes, you 
do not need to have a point selected. Simply hold SHIFT (or turn 
on Invert SHIFT action) and you’ll see green cones – they let you 
edit the point and its hierarchy. Finally, the affected direction of 
the hierarchy is the larger side of the green cone. 

These tools allow for quite a number of things, including 
pipes, chains, basic character or creature shapes and bodies, and 
so on. Here are some of the parameters of this tool:

Fill Inside. Fills the entire space between all points to create a 
solid volume object throughout the entire space.

Run brush along curve. Lets you perfectly indent or protrude 
areas along the spline. It has a number of options which are 
all self-explanatory – please explore these settings.

Stick to ground. Forces the points of your curve to be constrained 
to the surface of a volume object you click on.

Jagged line. By default the curves tool will create a smooth TCB-
spline. But with this option you can create a linear spline, 
essentially creating “pointy” intersections.

Snap to symm plane. Forces newly created points to be created 
on the symmetry plane when you click on or near the plane.

Invert shift action. This exclusively effects the four new curve 
modes. By default in any of these modes you must hold 
SHIFT to perform their alternate functions. This option will 
invert this setting, so that by default you use the alternate 
functions, and the normal default methods require you to 
hold the SHIFT key.
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Extrude same radius. In the Extrude mode, this option creates a 
new point with the same size as the point that you extruded 
from. By default a newly created point is the size of your pen 
cursor.

New curve. Adds another curve to your scene, in addition to 
your existing curve(s).

Tube. Resets the curve back to its default state.
Reset scale/angles. These two tools will reset any scaling or 

rotations you have applied to the selected curve.
Hardness. To use this you must have a point on a curve selected, 

then, by pressing this button, the selected point will become 
sharp and pointed.
Closed. Closes the spline curve 
between the first and last points 
on the spline. You can of course 
still add or remove points while 
using this function.
Del curve/point. These two 
functions allow you to delete 
curves and points on a curve. 
You can also hover over a point 
on a curve and hit the DELETE 
key.
Clear all. Clears all curves from 
the scene.

Save/Load. You can save and load entire sets of curves for use 
at a later time, or for distribution to other users.

Profile. This drop-down list contains a number of profiles, each 
will change the overall shape of the spline curve.

Apply to whole curve. With this any rotations, scaling or trans-
lation will apply to the whole curve centered from your cur-
rent selected point on the spline. The gizmo for the point 
will change, adding a new large, white circle around the rest 
of the gizmo. This new circle will allow for viewport based 
rotations.

Spline presets. There are other, and hopefully self-explanatory, 
settings for this tool. But one thing you should definitely 
explore are the spline presets. These let you perform many 
unique voxel sculpting techniques and styles. Please explore 
these – and add your own by using external files in the .obj 
or .lwo formats.

Snake. Clicking and dragging with the lmb creates a snake-
like shape in your viewport. Its position is based on your 
first click and your viewport perspective. As with the curves 
tool, you can reset it with the Tube button. You can select 
a number of profiles and of course also use spline presets. 
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One unique parameter for this 
tool is the Smoothing speed. 
The snake will smooth along 
its entire length, causing it to 
move. The higher the value, the 
more smoothing. (Min/max val-
ues: 1-5)
Spikes. Functions exactly like 

the snake tool, except that it tapers on the end point, caus-
ing a spike-like appearance.

Muscles. Lets you easily sculpt muscle- and tendon-looking 
shapes. You can achieve many different effects by, for instance, 

sculpting with this tool outside of a 
volume to create objects that look like 
wings. 

There are a number of settings in this 
tool:

Smoothing Speed. Lets you adjust the 
rate at which your stroke is smoothed.

Stick to ground. Forces your stroke to 
append to the surface 
of the object, instead of 
smoothing right through it.

Muscle types. Select between 
two different types: Muscle 
and Tendon. In the image 
on the previous page you 
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can see from left to right: Tendon, Muscle 2 and then Muscle 
1.

Toothpaste. This tool shares all of the options with the Mus-
cles tool except the muscle types. Its function is similar to 
its name: it is just like applying toothpaste to a surface. A 

big advantage is that it respects 
Pen alphas, so you can use it to 
create some rather unique rake 
brushes.

Primitives. This tool has undergone a big change in version 3.2. 
While retaining the oldrer primitives (Sphere, Cube, Ellipse, 
Cylinder, Cone, Capsule, Tube, N-Gon and the Gear), there 
are now Free Form Primitives (ffPrimitives)! These robust 
and powerful primitives let you create very complex shapes 
with just a few easy tweaks of the vertices, edges or faces of 

the lattice cage. There are a number of preset ffPrimitives, 
and you can also create your own using .obj files – see more 
on that below. A few of the parameters for the new ffPrimi-
tives are as follows:

Transform as whole. Gives you the ability to translate, rotate 
and scale using the default transform tool.

Local Symmetry. Enables local symmetry of the ffPrimitive, 
which gives you more creative freedom and control.

Misc. ResetPrim. Lets you reset any changes you’ve made to 
the object. 

EditPoints. Allows numerical values for each visible point of 
the lattice cage. Inner/Outer Radius & Thickness are only 
applied to some of the ffPrimitives, such as ffDisc and ffTube, 
they allow for the radius of the inner section or outer sec-
tion of the tube and the thickness of some of the primitives 
with keyable values. The dropdown list also has a few more 
options, usually different .obj files with different cages for 
similar shapes, such as ffDisc. When holding ctrl you can 
constrain the movement of your selection along its normal. 
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Text. Lets you place text along a spline curve, and create text in 
voxel form. Its parameters are identical to that of the Curves 
tool, so you should already be familiar with it after reading 
that section above. It has a few unique features: You can select 
a font for your text, you can of course type in the text you 
would like to make volumetric, and you can adjust the thick-
ness of this volumetric text.

Cloth. This tool is a cloth simulator which you can use to drape a 
polygon mesh over another object. There is a default Cloth 
with which you can test, but you are not limited to this as you 
can also import an external polygonal mesh. The parameters 
for this tool are:

Select mesh. Prompts you with a file-open dialog which lets you 
select a file (.obj, .lwo, ,fbx, .stl, .ply, and .3b) on disk to 
use as the object to be draped.

Subdivide. Subdivides the object you have imported. It can be 
used before or after you run the simulation.

Start/Reset. These two buttons starts and resets the simulation.
Pick from retopo. If you have retopologized something and it 

is in the Retopo tab, then you can use this button to select 
that mesh as the object to drape.

To retopo. Sends the recently draped mesh to the Retopo tab 
for further retopologization.

Other. Sets a number of other parameters, such as the Gravity, 
and the Friction of the draped object on the object you are 
draping over, as well as the Cloth thickness. For thickness, 
the higher the value, the thicker the cloth.

8.5 Surface Mode & Tools
In version 3.2 of 3D-Coat the surface tools have undergone 
some major changes. Most noteably there are new tools and 
speed improvements. To change to surface mode, you must 
click on the Cube icon in the VoxTree for the Layer you would 
like to edit in surface mode, you will then see a Wavy line icon 

which represents surface 
mode. Surface mode is much 
faster for sculpting than the 
regular volume mode. 

Only the surface mode 
tools will be available while 
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editing in this mode, plus with the Pose, 
Move and Transform tools. Some of the 
surface tools have counter-parts from the 
volume sculpting tools. There are a num-
ber of unique tools in this mode as well, 
which we shall discuss below:

Draw. The draw tool is great for quickly 
sculpting horns or things like that. It is similar to the the Air-
brush tool, but it only operates on the surface of a volumetric 
object.

Pinch. This is great for making tight edges, cavities and peaks, as 
shown on the picture below. It is indentical to the Vox Pinch 
tool, but it only operates on the surface of a volumetric object.

Shift. This tool drags the surface topology along with the brush. 
It’s great for producing wrinkles on a character or for mak-
ing cloth. It is indentical to the Vox Follow tool, but it only 
operates on the surface of a volumetric object.

Flatten. This tool has been improved in version 3.2, and now 
allows for a more predictable behavior. It flattens the area 

underneath your brush, based on brush 
size and intensity.
Chisel. This tool is new in 3.2. As you 
stroke along the object with your brush 
it will “chisel” away at the surface.
SfClay. Surface clay lets you quickly place 
strokes onto your voxel sculpt. The dif-
ference between this tool and the Carve 

brush is that it will also 
simultaneously smooth 
the surface after you’ve 
brushed it. It is indentical to 
the volume Clay tool, but 
it only operates on the sur-
face of a volumetric object.

SfFill. Surface Fill is a great way to fill in small holes and gaps in 
your objects. The higher the intensity, the more it will quickly 
fill the area under your brush.

Extrude Direction Settings. A few of the new tools in version 
3.2 have this option. It allows for user definable extrusions. 
The extrusion methods are: Average normal, View direction, 
Along axis (X, Y or Z), Vertex normal & Initial vertex normal. 
This setting is unique to the following three tools:

SfExtrude. Extrudes along the surface under your brush, based 
on your pen Size, Depth and Extrude direction settings.

Gum. This tool is great for making nice details on a mesh. It is 
unique for the surface tool 
set. It’s the fastest way to 
make skin, pores and wrin-
kles. The higher the reso-
lution of your object, the 
better the details look. This 
tool is commonly used to 
sculpt minute details onto 
an object. It is affected by the Extrude direction settings.
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Absolute. Extrudes the surface 
based on your pen Size, 
Depth and Extrude direc-
tion settings, while also 
maintaining the underlying 
surface details and topol-
ogy.

SfFreeze. This tool, which is 
new in version 3.2, is a very important addition to the toolset 
in 3D-Coat! It lets you mask with your brush, a mask which 
you can then use with any of the surface sculpting tools. It’s 
simple to use and powerful. You can also use common short-
cuts: ctrl+SHIFT+”i” inverts your selection, ctrl+”d” 
deselects.

Rapid. This tool’s name is very descriptive, as it’s one of the fast-
est tools in 3D-Coat to sculpt general shapes. It is almost the 
opposite of the Gum tool in this regard, as it doesn’t respect 
pen alphas but only brush Size and Intensity. Another great 
thing about this tool is that if you have two voxel object in 

the viewport that are overlap-
ping each other in space, it will 
try its best to compensate by 
building up the area between 
the two.

8.6 Commands
There are only a few Commands in the sidebar, but they are all 
very important. Let’s look at them.
Increase resolution. This command quadruples the number of 

voxels in the current object Layer. This lets a Layer thave much 
more detail. You can view the resolution of a Layer in the Vox-
Tree directly before the Layer’s name. If it has only the name, 
that means the Layer’s resolution has not been increased.

Clear. This command clears the current Layer in the VoxTree of all 
voxels.It is useful when you wish to keep the current Layer’s 
name and resolution – but not the voxels.

Smooth. This command uniformly smooths all of the voxels of 
the currently selected object Layer in the VoxTree.

8.7 VoxTree
You now have the ability to 
drag and drop Layers to do 
many things, such as moving a 
Layer to the trash, reparenting 
by dragging to a Layers + sign, 
or simply reordering the Layers 
to organize them. Let’s look at 
this.
Collapse child Layers. The 

minus next to any Layer 
lets you collapse any child 
Layers it may have. 
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Root. This is the base file or scene. You cannot edit this.
Visibility. By clicking the Eyeball icon you can toggle the visibility 

of a Layer on or off.
Cube/Wavy line. These icons toggle between volume mode and 

surface mode. Volume mode is represented by the 3D cube 
icon, surface mode by the Wavy line icon. 

Add Layer. The plus sign next to any Layer will add a new child 
Layer. If you add a Layer to the root, it will have no parent.

Layer name. Each Layer is represented by a horizontal bar. By 
double-clicking the bar you can change the Layer’s name. 

Layer resolution. If you have changed the resolution of a Layer, 
there will appear a number representing this change, like 
[2x], [4x], etc.

Now let us look at the icons on the bottom of the VoxTree:

Empty note. Creates a new child.
Trashcan. Deletes your currently selected Layer.
2 empty notes. Duplicates your currently selected Layer.
Ball. Edits the currently selected Layer’s shader properties.
2 empty notes w/grid. Duplicates the currently selected Layer’s 

resolution and transformation settings. Nothing else will be 
duplicated. This is useful when you need a new Layer with 
the same settings but not the same voxels.

Double-sided arrows. This icon is for the Symmetry copy tool. 
If you have sculpted on one side of a volume object you can 
use this fuction to copy all your work to the other side of the 

object. It works on any axis, as long as you have symmetry 
turned on along the preferred axis.

Grid. Increases resolution.
Down arrow note. This icon duplicates your currently selected 

Layer and decreases its 
resolution by a factor of 2. 
This is useful if you have an 
object Layer with too high 
resolution and you need to 
reduce it for easier editing. 
Be aware that you will lose 
details!

X-note. Clears the selected 
object Layer in the Vox-
Tree of all voxels. It is the 
same function as the Clear 
tool on the left side tool bar, 
as discussed in the Com-
mands section.

8.8 VoxTree Right-
click Menu
There are many functions in 
the right-click menu inside of 
the VoxTree. Some of them 
are unique to this menu, most 
however, are not. They are as 
follows:
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Delete. Deletes the selected Layer.
Add sub object. This is the same as clicking the “+” icon near 

the Layer’s name. It adds a Layer that is a child of the cur-
rent Layer.

Rename. Type your own name for the Layer, instead of the default 
“Volume X”.

Merge 3B file. Merges an external .3b file (the native format) 
into the scene.

Shader. Changes the shader. You can do it also in the Shaders 
tab:

Edit shader setting. Edit custom shader’s parameters, if it has 
them.

Import:

•	Merge points cloud. Merge set of points as a sequence of 
a small spheres.

•	Merge object. Merge 3D object in any of these file formats: 
.obj, .fbx, .lwo, .stl and .ply

Export:

•	Export scene. Exports the whole scene as a set of sepa-
rate objects.

•	Export object. Exports the current object.

•	Export pattern for merge. Exports the current object to be 
used as a pattern for the Merge object tool.

•	Export curve profile. Exports the current object as a profile 
for a curve.

Clone. Clones and transforms an object.
Clone with symmetry. Clones with symmetry and transforms.
Clone and degrade. Clones and decreases density twice. 

Clone space density. Creates space with identical density and 
transformation. It is important if you want to use the Copy 
tool without loosing quality. 

Increase density 2X. Increases the selected object Layer’s density 
twice. Object will decrease twice. 

Decrease density 2X. Decreases the selected object Layer’s den-
sity twice. Object will increase twice.

To global space. Moves the object to 0 on all axes. This is great 
when you need to move something directly into the center 
of world space to allow for a more perfectly symmetrical 
object when you apply symmetry. 

Extract skin:

•	Make hull using voxels. Makes a hull using the voxel algo-
rithm. It takes more time to calculate but works well for com-
plex topologies.

•	Make hull using surface. Makes a hull using surface extru-
sion. It is fast but can cause artifacts on complex topologies.

Extrude. Extrudes a whole object. You also have to set the Extru-
sion parameter:

Transform. Transforms a whole object using a special gizmo.
Apply axial symmetry. Applies axial symmetry of any kind to 

the object.
Quadrangulate object. Quadrangulates an object and drops it 

to Retopo Mode.
Quadrangulate and paint. Quadrangulates and drops an object 

to Paint Mode with microvertex painting mode.
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Quadrangulate for per pixel painting. Quadrangulates and 
drops an object to Pixel painting mode with per pixel paint-
ing mode.

There are a few things to note about the quandrangulation tools. 
It is a good idea to enable symmetry planes to force symme-
try during quadrangulation (assuming you want a symmetri-
cal object). If the object is not fully symmetrical the program will 
keep symmetry only whenever possible. If you do not like the 
auto-retopologized mesh, you can always go to Retopo Mode to 
manually adjust the mesh to suit your needs. Also, when using 
this function, 3D-Coat will automatically create a new sub-object 
in the Paint tab for each object Layer in the VoxTree.

Flip. Flips the current Layer on any axis (X, Y, or Z)
Merge to. Merges a copy of the current Layer to another Layer.
Move to. Moves the current Layer to another Layer.
Subtract from. Subtracts an object in the current Layer from the 

object in another Layer that you select. This is a very power-
ful function in 3D-Coat: it allows boolean subtractions of one 
object Layer from another.

Change parent. Changes the current Layer to another Layer or 
to the root.

8.9 Voxel Menu
Like most of the other major Tabs (or Rooms as they are also 
called), there is also an accompanying menu. We have already 
covered most of these options in previous sections. Any repeated 

functions are here only for your convience. Let’s take a look at 
them:

Increase resolution. This command quadruples the number of 
voxels in the current object Layer. This lets a Layer thave much 
more detail. You can view the resolution of a Layer in the Vox-
Tree directly before the Layer’s name. If it has only the name, 
that means the Layer’s resolution has not been increased.

Symmetry copy. If you have sculpted on one side of a volume 
object you can use this icon to copy all of that to the other 
side of the object. It works on any axis, so long as you have 
symmetry turned on along the preferred axis.

Clear. This command clears the current Layer in the VoxTree of 
all voxels.It is useful when you 
wish to keep the current Layer’s 
name and resolution – but not 
the voxels.
Smooth. This command uni-
formly smooths (or relaxes) all 
of the voxels of the currently 
selected object Layer in the 
VoxTree.
Unhide all. Unhides any hid-
den voxels.
Invert hidden. Inverts any hid-
den voxels.
Delete hidden part. Deletes 
any hidden voxels.
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Separate hidden part. Creates a new Layer in the VoxTree and 
place the previously hidden voxels into the newly created 
Layer.

Cast shadows. Enables shadow casting based on the global light 
inside the viewport. It is purely aesthetic.

Incremental render. Renders only the parts of the object that 
have changed since your previous render, thus giving a large 
boost in performance. This option is off when shadows are 
on, as shadows are dynamic and change the appearance of 
the rendered object.

Highlight. Toggles highlighting, if it is turned on for your selected 
VoxTree object will be highlighted a different color. When 
off, there will be no visible change. This efffect is dependent 
on the shader.

Accurate smoothing. Provides more accurate smoothing, at the 
expense of performance.

8.10 Shaders
The shaders tab is pretty straightforward. You simply rmb click 
to select a new shader to apply. If you rmb click a shader, you’ll 
see a few options:

DeleteShader. Deletes the shader you clicked.
Construct new shader. Lets you create a new shader. The new 

shader will be based on the shader you clicked.
Select default shader. Applies the shader you clicked as the 

default shader. Whenever a new volume object is created, it 
will have this new default shader applied.

Edit current object’s shader settings. This is pretty self-explan-
atory. Please check out each shader’s specific settings.

Refresh (all) preview(s). These two options refreshes the shader 
tab. It is helpful if you have trouble with a newly created 
shader not showing up as a selection.
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9. Render Mode 
In this section we shall discuss all that relates to the Render tab 
in 3D-Coat. First, one important point: do not hit esc to cancel 
a render if you still wish to use the image! You must wait until it 
is complete if you wish to have a final, useable image. Cancelling 
the render will not do this. The render engine must be allowed 
to continue its work until the render is complete!

9.1 Render Panel Functions
Render. Initiates the render of your frame or frame sequence.
View size. Lets you choose 

between rendering the 
Whole screen or a Custom 
size. If you choose a cus-
tom size you can then key 
in the X and Y values of the 
area you wish to render.

Render size. Lets you select a 
size for the rendered image. 
It is only active if you are 
using a custom size from 
the View size drop-down 
list. It will always be in mul-
tiples of the size you choose 
as the custom size.

Lightness. If you increase the 
value of the AO percent-

age you will probably need to also increase the Lightness 
of your scene, or it be be too dark.

AO percentage. The ambient occlusion changes your lighting 
type. A value of 0 gives you direct lightening, a value of 100 
gives you completely “overcast” lighting.
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Light scattering. Adjusts the 
amount of light that will be 
scattered. Higher values will 
give you softer shadows and 
softer specularity on shiny 
objects.
DOF degree. Depth of field 
focus. Produces a “lens focus 
effect” on your image. Set the 
distance from the DOF plane 

where objects remain in focus.
DOF plane position. Moves a red plane forward or backward 

to set the center of the depth of focus. Use the slider above 
to set the distance from the plane (in front and back) where 
objects should remain in focus.

Show DOF plane. Shows a focus plane where the details will 
look most sharp during DOF rendering.

Store alpha channel. Renders also an alpha channel. To use this 
option you must choose .tga as the output file format. If 
you are rendering an image sequence, the .tga format will 
be chosen automatically.

Anti-aliasing. Smoothes the edges of your rendered objects. 
Keep it checked!

32-bit rendering. Use this option only if have good enough 
graphic card (GeForce 8, 9 or better). 32-bit rendering pro-
vides a higher quality render by allowing for an “infinite” num-
ber of rays.

Render result. Choose the image format and a folder to store 
your rendered scene. Only apples if Render frame sequence 
is unchecked.

Render frame sequence. Renders a frame sequence rotating 
around the object or along the camera path. If checked, an 
additional parameter will appear:

•	Folder to store images. The name of a folder that will be 

created to store rendered frames. The folder is placed into 
Install dir/RenderedImages/... Please note that you cannot 
change this default path.
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•	Save lossless images. 
Saves images in lossless 
formats, namely .tga and 
. bmp.

•	Don’t overwrite files. Pre-
vents overwriting of files 
during a sequence render-
ing.

•	Closed spline. Use if you 
have several camera short-
cuts set up in the scene. In 
this case the Camera flight 
trajectory will be closed.

•	Rays per frame. Sets the maximal number of rays per frame 
during rendering. The rendering time is proportional to this 
value.

•	Frames to render. Sets the number of frames to render.

•	Counter clockwise. Sets trajectory direction: clockwise or 
counter-clockwise.

•	Render sub sequence. Check if you want to render or re-
render only some frames of a sequence. You must set the first 
and the last frame to render.

As mentioned in the beginning of this section: do not hit esc to 
cancel a render if you still wish to use the image! You must wait 
until it is complete if you wish to have a final, useable image. 
Canceling the render will not 
do this. Patience is a Virtue!
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10. Menu Panel 
10.1 File
New. Clears the current scene and creates a new one.
Open. Opens 3D-Coat’s native .3b format.
Open Recent. Displays recently open files.
Save. Saves file.
Save As. Saves files in .3b format. You can rename the file or 

place it into another directory.
Save Incrementally. Saves the file with an iterational file name, 

for example, “file_001.3b”, “file_002.3b”. 
Merge Object. Merges additional objects into the scene. Caution: 

Don’t merge objects with very different scales!

10.2 Import
Model for per pixel painting. Imports a mesh to paint directly 

over pixels in a UV-set. This approach will give better quality 
of painting over a texture because the painting will be per-
formed directly over pixels in a UV-set. Use this for normal 
maps and texture maps.

Model for microvertex painting. Imports a mesh for use with 
the microvertex sculpting and texturing tools. Use this for 
displacement maps and vector maps.

Reference Mesh. Imports the mesh to use as a reference for the 
retopology tool.

Big Mesh. Imports a large mesh (up to 16 million polygons). This 
function requires two meshes; a low-poly reference mesh and a 
high-poly mesh. Both should have the same non-overlapped 

UV-set. First import the low-poly mesh into scene using the 
usual import dialog, then load the high-poly mesh using this 
option.

Image Plane. Loads a flat square object and applies color and 
depth images for bump mapped tiled textures. Edit 2D 
images and add relief to them. Using the Image Plane tool 
together with Textures and the Offset tool you can loop the 
textures. Currently only square textures are supported. This 
option is very useful to make tiled displacement textures.

SL Object. Import sculpt map from Second life.

10.3 Export
Export Mode. Export the current object in .obj, .lwo, .stl and 

.ply formats. You will be prompted to select either a low-poly 
mesh, or a mid-poly mesh with 30k to 80k polygons and the 
normal map. If you’re in the Microvertex painting mode, the 
Export menu will have additional options:
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High-poly Mesh (Export w/
Microvertex). Exports a 
high-poly mesh with the 
number of polygons shown 
in brackets (x4, x16, x64 
times bigger).

Exit. Exits the program.

10.4 Edit
Undo.
Redo.
Mesh and Texture Resolution. Changes the number of polygons 

in the object and the size of the texture. You can change mesh 
resolution multiple times (like with other 3D software), but 
you can also do it in percentages, for example 50%.

Sync Layers with Ext. Editor. Lets you synchronize the current 
Layer with an external editor. You can set the file path to the 
editor in the Preferences. By default it is Adobe Photoshop. 
The alpha channel will contain the transparency mask. With 
this command the image editing program will open automat-

ically with your file. Then you 
can edit it and jump back to 
3D-Coat by pressing “ctrl+S”. 
Edit All Layers in Ext. Editor. 
Edits all Layers in an external 
editor. You can set the file path 
to the editor in the Preferences. 
By default it is Adobe Photo-

shop. This image editor should be able to edit .psd files. The 
texture will be stored with Layers to the .psd file, then the 
image editor will start. You can edit the texture and even add 
new Layers. When you save the file, 3D-Coat will automati-
cally reload it.

Edit Projection in Ext. Editor. Edit the current projection in 
Adobe Photoshop, or any image editor, using Layers. You can 
set the file path to the editor in the Preferences. By default 
it is Adobe Photoshop. This image editor should be able to 
edit .psd files. The projection will be stored with Layers to 
the .psd file, then the image editor will start. You can edit 
the projection. When you save the file, 3D-Coat will automati-
cally reload it.

Preferences
Autosave. The slider “Autosave time” adjusts the time interval 

for autosaving. The autosaved file has the name “autosave.3b,” 
which is located in the folder “User Data”.

External 2D-editor. The application in this file path is used to 
edit 2D-images. This editor must be able to edit .psd-files, 
so usually it would be Adobe Photoshop (but it could also 
be Corel Painter, for instance). This editor will be called by 
the functions “Edit,” “Sync Layers with Ext. Editor, Edit All 
Layers in Ext. Editor and Edit Projections in Ext. Editor”.

Near plane modulator. Tweaks the camera near plane to be able 
to move it closer to the surface.

Show hints. Hides or shows hints. Hints are located at the bot-
tom of the viewport.
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Axis. Shows or hides the axis.
Show “Focal shift” in the top panel (Show “Focal shift” slider 
in top panel).
Show “Falloff” in top panel (Show “Falloff” slider in top panel).
Compact interface. Toggles between compact/full interface.
Show import thumbnails on start page. 
Show interface thumbnails on start page.

Also you can specify:

Screen space grid size. 2D-grid size.
Grid subdivision. 2D-grid subdivision.
Background type. Vertical gradient/Background image/Pan-

orama.
Background image.
Sky box image.

Top background color.
Bottom background color.
Screen grid color.
Grid color. 3D-grid plane color.
Interface color.
Headers color.
Text and white icons color.
Edit area color.
Edit area border color.
Edit area highlight color.
Active tab color.
Passive tab color.
Tab background color.
Active tab font color.
Headers font color.
Buttons color.
Highlight color.
Hint background.
Hints text color.
3D button style. Uses 3D style for buttons.
Gradient in menu. Uses gradient style for menu.
Environment sphere map. Chooses a sphere map used for Show 

model with environment map”
Slightly lower shader quality. Select this option if you experi-

ence performance problems.
Use multi-core optimization.
Use MRT. Uses multiple render targets to speed up real-time 

normalmap updates.
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Pen sensitivity. Adjusts Pen 
sensitivity if you are using a 
digital pen.
Camera zoom speed.
Camera rotation speed.
Freeze pattern scroll speed. 
Freeze pattern scroll speed. You 
can change the freeze preview 
patterns in the freeze menu.

mouse wheel. Which parameter to change with mouse wheel.
ctrl+mouse wheel. Which parameter to change with ctrl+ 

mouse wheel.
SHIFT+mouse wheel. Which parameter to change with 

SHIFT+mouse wheel.
ALT+mouse wheel. Which parameter to change with 

ALT+mouse wheel.

Here is a list of suggested parameters for the last four options:

Normal maps export. Selects the standard for normal maps 
exporting: 3D-Max or Maya.
Padding. When you export 
textures you will be asked if 
you need a border around 
the texture clusters (padding). 
This option lets you answer the 
question automatically.

Padding width. Used when 
texture exporting.

3 D Co n n ex i o n  o p t i o n s. 
3D-Coat supports the 
3D SpaceNavigator from 
3DConnexion. You can find 
all the options to control 
your 3D mouse here.

10.5 View
Relief only. Displays relief maps only in the viewport.
Flat shade. Displays a flat shaded view in the viewport.
Specular only. Displays only your specular maps in the viewport.
Show displaced mesh. Shows actual mesh displacement. The 

vertices of the mesh will be displaced along the normal in 
correspondence with the displacement map.

Wireframe. Shows the wireframe of the model.
Low-poly. Views and edits low-poly model with normal map.
Smooth Shade. Enables Smooth shade (hotkey “5”).
Low Smooth Shade. Enables Low Smooth Shade (hotkey “7”).
Environment Shade. This is the default. It displays all the maps 

you have applied in the viewport.
Grid. Turns on/off the 3D-grid plane in the 3D viewport.
Axis. Shows/hides the axis.
Grid 2D mode. Turns on/off the 2D-grid of the screen.
Snap to Grid. Snaps to the 2D grid. This is usually used in conjunc-

tion with the Curve tools (draw with spline, putting text on 
curve and putting picture along spline). With Snap to grid on 
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you can snap the points of the 
curve to the 2D-grid and draw 
very exact shapes.
Snap to low-poly vertices. 
Snaps your pen to low-poly 
vertices. Helpful when you are 
retopologizing or texturing.
Orthographic Projection. Tog-

gles perspective/orthogonal projection.
Adjust subpatching. Improves the visual appearance of mesh 

displacement using subpatches. Subpatching is a grid NxN 
on every face. Use this option only if you are certain your 
video card is powerful enough.

10.6 Textures
Import. Imports diffuse, specular, normal and displacement maps 

in .tga, .bmp, .png, .jpg or .dds format, and Layers color 
in .psd format.

Export. Exports diffuse and specular maps in .tga, .bmp, .png, 
.jpg or .dds format, normal map (tangent space for low-poly 
mesh) in .tga format, displacement maps in .tif format, and 
Layers color in .psd format. Note: When you choose Import/
Export displacement a context window will appear.

In the drop-down list there are four items for map type:

Use Original UV. This option is important for models with over-
lapped UV clusters, for example with mirrored UV’s. In this case 

you should load the model with the “Keep clusters” option 
on UV-coordinates will be changed in such a way that tex-
ture clusters will not overlap each other. Models and textures 
will be exported with the original UV-set if the option “Use 
Original UV” is checked, otherwise they will be exported 
with the new UV-set.

Save Specularity as Alpha in Normal Map. Saves the specular 
channel to a normal map as an alpha-channel.

Save Displacement Map to Alpha. Saves the displacement to 
the alpha channel of the normal map.

Adjustments. There are many Layer adjustments commands, 
such as: color to specular, invert color, invert specularity, 
set height to zero, make transparent, remove specularity, 
smooth current Layer, sharpen current Layer, hue/satura-
tion/lightness, CMYK, transform color space, brightness/
contrast, RGB. All of them can be viewed with real-time pre-
view and they can be applied not only to the current Layer 
but also to all the Layers.

Import UV. Imports an object that contains a UV-set. The new 
UV-set will replace old one.

Export UV. Exports an object without textures. This command 
could be used in pair with Import UV. You can export a UV-
set, adjust it externally and then import it again.

Export SL Sculpt Map. Export a “Second Life” sculpt map.
Texture UV Editor. With the built-in 2D texture editor, you can 

draw in 2D and 3D windows simultaneously. You can paint in 
3D and the results will be shown in the 2D window simultane-
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ously and vice versa. You can select one UV-set in drop-down 
list left-top of the 2D Texture editor window to paint in it.

Offset tool. You should load only square images with this tool. 
It comes in handy to create tiled textures with bump and 
specular. Once a square object is loaded, you will be offered 

the “Offset tool” window where offset values can be speci-
fied: U offset, V offset and texture shifting horizontally and 
vertically in accordance. 

UV Manager. If there are several objects in the scene, separate 
objects can have a separate UV. Use this command to manage 
them. You can group several materials into a single UV-set.

Texture Baking Tool. This lets you bake details to a normal or 
displacement map. This can be used even when the surface 
topology doesn’t match perfectly between your reference 
mesh and low-poly mesh. This tool is quite detailed and has 
it’s own section below, please see that section for further 
information.

Calc Occlusion. Allows calculating the global illumination from 
many spotlights that are distributed over the half-sphere. 
The grey scale results will be written to the current Layer. 
So it is better to create a new Layer and set the color opera-
tion “Modulate” or “Modulate2X”. The Calc Occlusion tool 
is especially optimized for high polygons (several millions), it 
is fast but it still need some time with high polygon counts:
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Light sources (distribution of lights).
1) over hemisphere 
2) over sphere 
3) over hemisphere + sphere

Lighting render target. You must choose a Layer where the 
occlusion calculation is placed. You can choose to add a new 
Layer automatically or overwrite the current Layer. In the 
first case, do not forget to delete a new Layer for the light 
calculation. Also a new color option “To time” is added for 
a new Layer. In the case of rendering the former Layer, all of 
its color information will be deleted.

Lights count. The more lights, the longer the calculation. The 
more light sources, the better the quality of lighting but the 

longer its calculation. The maximum value is 256, the mini-
mum value is 16.

Post-smoothing steps. Sets the amount of post-smoothing 
steps after occlusion calculation.

10.7 Symmetry
Symmetry in 3D-Coat is used when drawing, sculpting or reto-
pologizing on objects. For quick access, press the “S” key. In this 
menu you will find a number of settings. You can toggle on/off 
symmetry, turn on a specific axis for symmetrical work (X, Y or Z 
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axes), or simply toggle the visibility of the symmetry plane. By 
default, symmetry is not activated. You can also change the posi-
tion of the symmetry plane by pressing and holding the tab key.

10.8 Windows
Popups. With Popups you can show any popup window in the 

viewport easily. There are many popup windows – and all of 
them are useful. Some of the popups are already located in 
their tabs in the right side panel.

Sliders. View any of the available sliders for all tools that use one.

The rest of the options are self-explanatory. You can reset the cur-
rent Page or all pages to their defaults, save your page or whole 
Workspace layout to a file, and also load it when needed.

10.9 Texture baking tool
This tool lets you bake details to a normal or displacement map, 
even if the surface topology doesn’t match between the two 
meshes you wish to bake – the reference mesh and the low-poly 
mesh. Here are some detailed steps to use this tool:

For a Displacement map. 
	 Turn on.

Uses current low-poly mesh
Smoothes mesh
Preserves positions

	 Turn off.
Uses original positions

For a Normal map. 
	 Turn on.

Uses current low-poly mesh
	 Turn off.

Uses original positions
Smoothes mesh

You’ll need to have “Use current low-poly mesh and “Smooth 
mesh” turned on, with “Use original positions” turned off. To get 
a displacement map you should set the “Smooth mesh” option, 
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because displacement is calculated as the difference between 
the object in the scene and the sculpted geometry. Check “Use 
current low-poly mesh...” option if you want to project on the 
current mesh. In this case it is better to check ”Use original posi-
tions...” and “Smooth mesh” if you want to have displacement 
and uncheck them if you want a normal map only.

As you can see by the normal maps images here, the 
right one is more detailed then the other. It was gener-
ated using the Texture Baking tool, the left one was done 
with a simple export function.
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12. Customize Hot Keys & User Interface
3D-Coat is fully customizable, and it is quick and easy to do. All 
UI settings, hotkeys and other customized information are stored 
in a small XML file, allowing for easy distribution of all custom-
ized presets. 

12.1 Customize Hotkeys
To define a hotkey is very simple. All you need to do is point your 
cursor over the item you would like to set a hotkey for and press 
the END key – you will then see this prompt: 

You can now press the key(s) you would like to assign to the func-
tion. Keep in mind that nearly every button or menu item you see 
in 3D-Coat already have a custom hotkey. If a hotkey is already 
used, it is no problem to re-assign the hotkey to whatever new 
hotkey you would like.

12.2 Customize 
User Interface
The UI layout of 3D-Coat is fully 
customizable. By default there 
are three UI themes included 
in the installation. They are 

“Dark”, “Grey” and “Light”. 
You can change this by going 

to Edit–>Preferences–>Load, and you will then be directed to a 
folder named “OptionsPresets. There are 3 .xml files in it, and each 
of them is corresponds to an interface theme. To load the themes, 
simply select one .xml file and click Open. You can of course edit 
many more parts of the UI and create your own UI theme and 
save it as an .xml file. Just go to Edit->Preferences. Here you can 
customize the color of text, interface background, header, but-
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tons, grid, background, and so 
on. You can also turn on/off 3D 
button style, Gradient menus.

After all these done, just 
save the .xml file, and all the 
new customized information 
are stored. You can load it any-
time on your own systems or 

share it with your friends and colleagues. Simply press the but-
ton Save in the Preferences panel. 

You can even change the icons of the tools to your own, just 
go to the installation folder of 3D-Coat. In the subfolder path 
textures\icons you will find the source .psd files of the icons, they 

are Baseicons.psd and Smal-
lIcons.psd, open the .psd file 
in Photoshop and create your 
own icons. When finished, save 
them in the .dds format, keep 
the name and replace the origi-
nal Baseicons.dds and Smal-
lIcons.dds. The next time you 
start 3D-Coat it will load all the 
new custom icons.
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13. CUDA
13.1 CUDA Basics
3D-Coat uses CUDA acceleration for voxel sculpting only. Voxel 
sculpting requires more computing resources because it handles 
pictures in volume. So we decided to use CUDA to speed up 
volume operations. CUDA is supported by all the recent NVidia 
cards, starting with the 8-series. 

However the acceleration is hugely dependent on the num-
ber of processors available on the card. The real advantage of 
CUDA over a 4-core CPU can be achieved only if the GPU has more 
then 64 processors, otherwise the 4-Core CPU alone will yield 
a better speed. So there is no reason to use CUDA acceleration 
with some video cards, even though they support the technol-

ogy – like the GeForce 8400/9400, 8500/9500, G100, G120, G130 
and QuadroFX 1700 – because they have less than 64 processors. 

We can recommend any card from GeForce 9800GT (it’s very 
inexpensive) and higher. Acceleration speed is dependent not 
only the number of cores number but also on memory bandwidth. 

CUDA gives the best speed advantage if you are applying 
masks and materials over voxel sculpture with big brushes. The 
speed advantage depends considerably on the tool used. 

13.2 The Benchmark
Here is the benchmarking info for a standard PC with a 4-core 
CPU (Q6600, 2.4 GHz, GPU 9800GT). We ran 6 tests, using several 
types of drawing with a mask either enabled or disabled. 

Draw with sphere: CUDA+thin pen(10) Avg. FPS:31.3
Draw with sphere: CPU+thin pen(10) Avg. FPS:30.5
Carve: CUDA+thin pen(10) Avg. FPS:34.1
Carve: CPU+thin pen(10) Avg. FPS:30.5
Carve with mask: CUDA+thin pen(10) Avg. FPS:31.0
Carve with mask: CPU+thin pen(10) Avg. FPS:26.4
Draw with sphere: CUDA+thick pen(40) Avg. FPS:13.6
Draw with sphere: CPU+thick pen(40) Avg. FPS:10.4
Carve: CUDA+thick pen(40) Avg. FPS:18.3
Carve: CPU+thick pen(40) Avg. FPS:10.3
Carve with mask: CUDA+thick pen(40) Avg. FPS:14.3
Carve with mask: CPU+thick pen(40) Avg. FPS:7.2
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The largest advantage of CUDA over CPU-only is visible when 
a mask is used. The faster FPS numbers means, of course, more 
speed. 9800GT is a very low-priced card, but using a GTX260 or 
later or a QuadroFX with a large amount of cores will give the 
best speed. 

It is cheaper to buy a good video card than, for example, a 
Core i7 processor. 

We can also recommend buying a video card with 1GB or 
more of memory, because it will allow you to edit really large 
textures in 3D-Coat. 

CUDA’s efficiency is limited on very large brushes, so, when 
reaching a particular radius, CUDA will be automatically disabled 
in tools like the Airbrush, Increase, Build and Smudge. On a scale 
of 1:1 it is a radius of around 65. The surface and object tools are 
not getting any advantage from CUDA.
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14. FAQ/Additional Tips 
14.1 For Your Information!
Sometimes my painting operations become very slow. How 
can I best avoid it?

•	Painting over large single faces will be much slower then 
over divided faces. So try to avoid too big faces in UV-space. 
Divide large faces whenever possible.

I am getting the error message “The application failed to start 
because d3dx9_38.dll was not found”. What should I do?

•	Go to our Download page, look for the DirectX 9c download 
and install it. Even if you have DirectX 10 installed you need 
to update DirectX 9. DirectX 9 and 10 are independent, so 
this procedure is quite safe. 

I want to upgrade my video card to speed up 3D-Coat. What 
should I choose?

•	Using modern nVidia cards is best, due to CUDA. You can 
choose from NV 8800GT (lowest price) to GTX 285 and higher. 
There is no reason to use multiple GPU cards (SLI) for 3D-Coat. 
The most important factor for CUDA performance is the num-
ber of cores – it should be 120 or more. Video RAM is impor-
tant also, because it determines the maximum texture size 
that can be edited in 3D-Coat. Every pixel takes 8 bytes, so 
you can easily calculate the maximum size of the texture that 
can fit into the GPU’s memory. We recommend you buy cards 
with at least 1 Gb of RAM, even more is even better. 

Do I need to uninstall 3D-Coat every time I install your new 
software upgrades?

•	No, you can install the update simply by overwriting the 
existing installation (at least until we release a major, non-
free version upgrade).

I am unable to register – every time I enter serial number 
and press Register, 3D-Coat restarts and asks for the serial 
number again. How can I exit this loop? 

•	Check if you might have copied to the clipboard extra char-
acters – or missed some characters 

•	Check that the serial number is for 3D-Coat Version 3 – often 
users are entering serial numbers for Version 2. Version 3 
serial number begins with 3DC3SN-.

•	If you are under Vista x64, please ensure that you are running 
3D-Coat as an administrator. 

•	If the problem still persists try to delete the file License.dat 
from the 3D-Coat installation folder manually. 

There are too many texts hints in the interface, is there a way 
to hide them?

•	If you are new to 3D-Coat, 
it isn’t recommended that 
you hide the hints, because 
these will really be helpful 
for your study. But you can 
hide the hints anytime you 
want, just go to the menu 
Edit->Preferences->Show 
hints and uncheck that 
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checkbox. You can turn on or off the big bottom hints sepa-
rately by using “Show big hints on the bottom panel”.

I am using Vista/XP 64-bit and 3D-Coat does not respect my 
Wacom pen pressure. What should I do?

•	3D-Coat works well with 64-bit drivers. Get the latest Wacom 
driver here: www.wacom.com/downloads/drivers.php

Can I move/rotate/scale the objects but not the camera?

•	Yes, you can. In the “Sculpt mode” of tools panel, select the 
“Select/Move” command – then you can select the object 
you want to move/rotate/scale.

How can I adjust the pivot point?

•	In 3D-Coat, the pivot point is dynamic and based on the 
currently picked point (where you cursor last pointed on the 
model). But you can set the pivot point manually using the 

“F” key. Also, please see the Camera menu – it lets you pick 
the best pivot mode.

What’s the difference between the normal maps standard 
used in 3ds Max and Maya?

•	The green channel is reversed. You can select the normal 
maps standard in the menu View->Options. 

When should I use the DX version and when the GL version?

•	It depends on your hardware. 3D-Coat has two Graphics 
Modes: DX (DirectX) and GL (OpenGL). the GL mode usu-
ally runs much faster than DX mode on professional Quadro 
graphics card, while the DX mode will run faster on consumer-
level game graphics card. 

What’s the difference between “Depth” and “Sculpt mode”?

•	In 3D-Coat there are two types of sculpting modes: one is 
image-based and another is mesh-based. “Depth” is image-
based sculpting – in this mode you are drawing the depth by 
creating a vector displacement, the normal map and displace-
ment map is generated “on the fly.” If you want to get hold 
of the normal map, just save it – it’s not necessary to wait a 
long time for baking, because the normal map is generated 
in real-time. 

•	When you enter “Sculpt mode”, you enter the mesh-based 
sculpting mode. In this mode you you’re really changing 
the vertex positions of the mesh. If you want to get correct 
normal map in this mode, you may use Textures->Texture 
Baking Tool.

What’s the use of the Cavity painting?

•	Cavity painting lets you paint in the crevices of the surface 
without affecting the rest of the area, and vice versa.

I selected the command “View->Environment Shade”, but 
there seems to be no change, why?

•	You can only use “Environment Shade” if you have a specu-
larity map in the model. That means if you haven’t painted 
specularity on the model, you will not see any change. 

Why is drawing with the SHIFT key so confusing?

•	Different sequences of the SHIFT key and the lmb will result 
in different effects. If you first press and hold SHIFT and then 
draw with lmb, the surface will be smoothed. But if you first 
press and hold lmb and then press SHIFT and draw, you will 
get straight lines – just like in Photoshop.

How can I create a seamless texture using 3D-Coat?
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•	It is easy to use 3D-Coat to create seamless textures and 
bump maps. Just go to menu File->Import->Image Plane, 
you may want to use Textures->Offset tool as well. You can 
read more about it on page.

What are the best practices regarding memory management 
and increasing stability?

•	When 3D-Coat is run you can see the amount of free memory 
in the left bottom corner. If this value becomes too low (200-
300 MB), the program can become unstable. These tips will 
help you to increase stability. 

•	3D-Coat consumes much memory for highly detailed objects, 
so it is important to allow 3D-Coat to use as much virtual 
memory as possible. So, please adjust your virtual memory 
settings as shown on this picture (this is taken from 32-bit 

Windows XP, things will be simi-
lar with other OS versions). Go 
to MyComputer->Properties-
>Advanced->Performance-
>Advanced->Virtual Mem-
ory->Change. Please set this 
number to 4096KB. 3D-Coat 
supports even larger virtual 
memory ranges. If you are 

using 64-bit Windows you will be able to use up to 4GB of 
virtual memory. So, using 64-bit Windows with 3DC is the best 
choice. If you are using 32-bit Windows, you can ordinarily 
use only 2 GB of virtual memory – but you can increase that 

size using the special “/3GB” option in the file boot.ini. With 
that option you will be able to use 3GB of memory with 3DC. 

How can I find and safely edit the file “boot.ini”?

•	Right-click My Computer->Properties. The System Properties 
dialog box will appear.

•	Click the Advanced tab.

•	In the Startup and Recovery area, click Settings. The Startup 
and Recovery dialog box will appear.

•	In the System startup area, click Edit. This will start Notepad 
and open “boot.ini”.

•	In the [Operating Systems] section, add the following switches 
to the end of the startup line that includes the /fastdetect 
switch: /3GB

•	Save the changes and close Notepad.

•	Click “OK” twice to close the dialog boxes, and then restart 
the computer for the change to take effect.

You can read more about the /3GB option here:
http://technet.microsoft.com/en-us/library/bb124810.aspx
http://www.vfxpedia.com/index.php?title=FAQ/3GB_Switch
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15. Contacts & Credits
Official 3D-Coat web-site:
www.3d-coat.com

Lead Programmer: 
Andrew Shpagin
support@3d-coat.com

Web-designer/Webmaster: 
Vladimir Popelnukh
web@3d-coat.com

Sales manager: 
Stanislav Chernyshuk
sales@3d-coat.com

PR manager: 
Denis Yanev
d.yanev@3d-coat.com

Authors of the manual: 
Luo Chen, Marina Shpagina, Dwayne Ferguson, Daniel Yarmak, 
Klaus Nordby and Javis Jones

Manual design:
Klaus Nordby

92 | 94NewContents Start Right Side Panel Paint Sculpt Retopo UV Mode Voxels Render Menu Hotkeys Customize CUDA FAQ/Tips Credits

http://www.3d-coat.com
mailto:support%403d-coat.com?subject=
mailto:web%403d-coat.com?subject=
mailto:sales%403d-coat.com?subject=
mailto:d.yanev%403d-coat.com?subject=


16. Printing this manual
You may of course also print this manual! But you probably don’t 
want to waste unnecessary ink. Please follow these simple instruc-
tions to remove the grey background in this PDF document.

In Adobe Reader, first move your cursor to View->Navigation 
Panels->Layers. You should then see, on the left side, a new 
panel called “Layers”. You will only see “3DC-Manual” or some-
thing similar. Then click next to the “+” icon to expand the Layer 
system. You should see a layer named “Gray background”, and 
right next to it a visibility icon, represented by an eyeball. Click 
the eyeball to toggle the visibility off. All this is clearly shown in 
the images on this page. You should now see a white background in this document, 

and can print it using much less ink.
If you want to save even more ink, you can also hide the layer 

named “Images” – and only print the text parts of this manual.
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